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Abstract 

Due to constant changes in Assistive Technology, it can be difficult to keep up with               

advancements. Working with the Seven Hills Foundation, we hosted a pilot event that taught              

their staff, disabled individuals, and the public about the latest in AT. We conducted exit surveys                

to collect feedback to determine if Seven Hills should host the event annually. All of our                

planning documents and recommendations were given to Seven Hills as a database to expedite              

their planning for future events.  
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Executive Summary 

There are organizations in the U.S. that help disabled individuals overcome the problem 

of how to properly use an assistive device to help them perform daily activities. These devices 

were designed to create a higher quality of life for these individuals, but only if they have the 

knowledge to operate them. Since these assistive devices are changing rapidly due to 

technological change, organizations are having trouble keeping up with these changes, including 

one organization in the Greater Worcester area, Seven Hills Foundation (SHF). 

Disabled individuals will use assistive technology if it’s beneficial, effective, and 

affordable.  Because of this, it becomes very important for the disabled individuals and their 

aides to understand different types of assistive technology. Without the knowledge of how to use 

these devices, the devices may not be as helpful.  However, with the proper knowledge, the aides 

can help increase the quality of life for disabled individuals.  This forms a direct relationship 

between an aide’s knowledge and the quality of life for a disabled individual.  Our project aimed 

to begin to create a solution to this problem by determining whether a mini Expo that was 

designed to help the aides improve their, knowledge and confidence with AT so that their 

disabled clients would be more satisfied and empowered by the services that SHF was providing 

to them. 

The main objective of this project was to organize and help carry out a mini Expo so that 

Seven Hills could use our results to potentially put on a larger Expo. To meet this objective, we 

have identified the following sub-objectives. First, we needed to identify possible vendors and 

speakers who are contributing to helping disabled individuals and who could attend the Expo. 
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Second, we had to determine with the Seven Hills staff all costs associated with carrying out an 

Expo.  Third, we had to determine the effectiveness of the mini Expo as a way to help SHF 

design a larger Expo in the future. Finally, we wanted to determine the best means possible to 

help Seven Hills put on future Expos more easily. To accomplish this, we compiled all of our 

findings into a database with a manual that is easy to navigate, so that SHF staff could find 

specific information relevant to any part of the Expo planning process.  

After we carried out the Expo, we gathered results, recommendations, and conclusions 

from various surveys that were distributed to Expo staff, attendees, and vendors. From the 

attendee survey, we found that more than 85% of attendees were happy with the organization and 

layout of the Expo. The attendees also said they would be very interested in attending another 

Seven Hills event or Expo in the future. From vendors, they all were happy with how the Expo 

was conducted and they would come to another event. The Expo staff had very similar 

responses. They would all come back to the Expo, however, only 83% said it exceeded their 

expectations. There were a few major recommendations that we observed, the first being that the 

Expo was scheduled to be too long. The sessions worked well, however the sessions were too 

long. The next recommendation was that the layout needs to be improved slightly so we can 

catch everyone for the exit survey as some of the attendees walked behind the vendors to exit 

and missed the survey. The last major recommendation was to have more stations that are 

interactive so individuals with disabilities can try more devices. 
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1.0 Introduction  

Assistive Technologies (AT) enhance the capabilities of countless individuals struggling 

with varying disabilities. The Rehabilitation Engineering Research Center on Communication 

Enhancement (2016), defines an assistive technology device as “any item, piece of equipment, 

or product system, that can be acquired commercially, adjusted, or even custom built, that is 

designed to enhance, retain, or improve the quality of life for individuals with disabilities” 

(paragraph 1). With employment of biomedical engineers expected to increase 23% between 

2014 and 2024, the rapid advancement of AT is also expected (Bureau of Labor Statistics, 

2015). This growth is much higher than in other occupations and a direct result of the 

increasingly more high tech medical devices. Because of these advances, it can be difficult for 

organizations and families assisting disabled individuals to keep up with the increasingly 

sophisticated technologies. 

According to Mrs. Jean Des Roches (personal communication, November 21, 2016) of 

the Seven Hills Foundation (SHF), it can be difficult for SHF staff to keep up with AT. Keeping 

the staff and clients appropriately trained can be very challenging. Caregivers cannot train their 

clients without understanding these devices themselves. Unfortunately, due to a lack of time or 

incentives to receive training, and because of constant upgrades in AT, this can be a challenge. 

Because of this, Seven Hills managers feel the organization can better fulfill its ability to serve 

those with disabilities and improve their quality of life by giving staff more and better training 

opportunities. But how best to achieve this training is still uncertain. 
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The problem of how to keep their staff up to date on the changes in AT is a problem for 

many organizations that work with people with disabilities. SHF and other similar organizations 

have made many attempts to solve this problem before.  Some of these organizations have had 

Expos for AT devices each year. However, these Expos have changed locations and are therefore 

no longer able to support the people in the previous locations.  As the devices found at these 

Expos are expensive, Seven Hills also has provided information to help individuals and families 

purchase these devices through loan programs.   

Seven Hills has attempted to solve all of these problems through the use of research 

projects (Bingel, 2016), workshops, clinics, and many other approaches.  However, these 

strategies have not completely solved their problems.  Seven Hills staff feel that a mini Expo 

might be a possible first step towards putting on a larger Expo, should the mini Expo prove to be 

successful in training both staff and clients in new AT. However, so far SHF has never carried 

out any type of Expo. 

The goal of our project was to help SHF determine if an Expo would be a good solution 

for achieving better training and exposure to AT for staff and clients. To achieve this goal we 

helped organize host a pilot Expo at Seven Hills that could lay the foundation for any larger 

Expo they might choose to host in the future. We identified how to organize and run an Expo, 

what previous AT Expos have accomplished, who potential speakers and vendors would be, 

what hands-on AT activities could be included in an Expo, and what local and state resources 

were available for carrying out an Expo. We also provided SHF with a database that organized 

all the information we had gathered in the process of planning and hosting the pilot Expo. After 

completing the Expo, we evaluated how well an Expo would help Seven Hills achieve its larger 
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goal of training and education. The SHF staff and the assistive devices they prescribe help 

disabled individuals develop the means to pursue employment, recreation, social interaction and 

a higher degree of independence.  Clients also directly benefit from SHF staff being more 

familiar with a wider range of AT. 
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2.0 Background 

There are a wide variety of events that are designed to help individuals with their 

disabilities. In this chapter, we will discuss the disabilities and Assistive Technologies (AT) that 

are the focus of the work that the Seven Hills Foundation (SHF) does. Also, we will provide 

information about a few general educational events, and events specifically teaching AT. In this 

chapter, we discuss the specific components involved in carrying out an Expo. 

2.1 Assistive Technology Solutions for Disabilities Served by 
Seven Hills 

Seven Hills Foundation (2016a) is an integrated health and human services nonprofit 

organization. Through their integrated clinical, educational, and community-based supports led 

by their 3,700 employees, they help people " SEE the possibilities, BELIEVE in themselves, and 

ACHIEVE their dreams" (Paragraph 1). 

2.1.1 Assistive Technology 
Assistive technology (AT) is defined as “any item, piece of equipment, or product 

system, whether acquired commercially off the shelf, modified, or customized, that is used to 

increase, maintain, or improve functional capabilities of individuals with disabilities” (Assistive 

Technology Program Department of Disabilities, 2016, Paragraph 1). AT is provided through 

devices and services that were first defined in federal law in the Individuals with Disabilities 

Education Act (IDEA) of Public Law 101-476 (United States of America S.a.H.o.R., 1990). AT 

does not include a medical device that is surgically implanted, or any replacement of such device 

(Georgia Department of Education, 2004). The IDEA uses the term “device” to provide a broad 
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definition, to allow flexibility to refer to a range of assistive technology solutions. Below is a 

chart that will show the differences between similar low-tech and high-tech Assistive 

Technologies. 

 

AT Category Low-Tech High Tech 

Education Pencil Grip / Adapted Pencil Portable Word Processor 

Communication Word Prediction Software Text to Speech 

Deaf and Hard of Hearing Voice Amplification Speech to Text 

Blind and Low Vision Glasses Magnifying Software 

Mobility Wheelchair Electric Wheelchair 

Table (1).  Examples of low to high-tech technologies. (Autism Adventures, 2011) 

High-tech devices are often more expensive and may be controlled through electronic, 

digital, or computer components.  They also may require training courses to understand how to 

properly operate them. Some examples of these devices are power wheelchairs and scooters, 

digi-drive technology, voice recognition software, magnification software, and voice activated 

devices (Georgia Department of Education, 2004). The digi-drive technology is a machine 

operated through the use of a joystick made for the disabled individual’s fingers. Voice activated 

devices, such as a telephone, help those who have severe physical disabilities and do not have the 

capabilities to operate simple devices such as a telephone.  

Although these technologies can prove to be more useful to a disabled individual, they 

can be extremely costly. Low-tech AT devices may be less advanced than their high-tech 

counterparts, but they still can be very effective. In most cases, low-tech devices require little to 

no training to use and are relatively inexpensive compared to high-tech devices. Some of these 
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devices may have electronic or complex components (Riviere, 2003). However, these devices are 

much less advanced than the complex components of the high-tech assistive technologies. 

According to Georgia’s Assistive Technology Act Program (2016), some examples of low-tech 

devices include reachers and grabbers, specialized grips for writing utensils, manual wheelchairs, 

audiobooks, alternative computer mice or keyboards, and electronic organizers. Due to the 

simplicity of low-tech devices and the limited amount of training required to use them, these are 

typically the devices that most people tend to prefer.  These devices are also popular among 

consumers as they are the better financial choice. “Assistive technology devices are available in 

a variety of categories to address functional capabilities of students with disabilities” (para 8). 

 These categories include but are not limited to: Academic and Learning Aids, Aids for Daily 

Living, Assistive Listening Devices and Environmental Aids, Augmentative Communication, 

Computer Access and Instruction, Environmental Control, Mobility Aids, Pre-vocational and 

Vocational Aids, Recreation and Leisure Aids, Seating and Positioning, and Visual Aids, which 

are all defined in Appendix F (getATstuff, 2016, Paragraphs 3-13). Assistive technology presents 

itself in a wide range of forms with high and low-tech variants, allowing individuals to make a 

choice that best fits them. 

 
 
2.1.2 Assistive Technology Services  

Consistent with Georgia’s Department of Education (2004), Assistive Technology 

 service is defined as “Any service that directly assists a child with a disability in the selection, 

acquisition, and use of an assistive technology device” (Paragraph 24). Assistive technology 

services span multiple disciplines, which are described in depth in Appendix G.  Assistive 
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technology services are critical to the use of assistive technology devices and their selection. 

2.1.3 Seven Hills Superusers 
Seven Hills has their own internal staff group that works as superusers. These workers 

provide services to individuals throughout SHF’s network and inform them on how to operate 

different AT devices. They each can have their own area of expertise in the different areas of 

assistive devices, or they can just have a broad knowledge on many different types of devices. 

According to Steve Kessler of Seven Hills Foundation (Personal Communication, February 22, 

2017), “There are no certifications necessary to become a Superuser”. 
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2.2 Contents of an Expo 

According to the National Organization on Disabilities (1998), 29% of all families in the 

United States have at least one member with a disability. That means roughly 20.3 million 

families might need or are already using assistive technology. Whether a person has an assistive 

device or needs one, they need to learn how to use the technology by themselves or by their 

caretakers. That number does not include the friends, family members, caretakers, assistants, 

doctors and physicians who need to learn the AT devices as well. With this being said, there is 

no best option when it comes to educating the public about assistive technology. The Leadership 

Conference on Civil and Human Rights and The Leadership Conference Education Fund (2010) 

provide many different options, like individual training, assistant training, Assistive Technology 

Fairs, Programs and Expos, online tutorials and more.  

Although advances in modern technology have allowed individuals and companies to 

promote their products and ideas online, hosting an event to promote technologies attracts 

consumers by appealing to them on a personal level. The Bureau International Des Expositions 

(2016) defines an Expo as an “event that aims at educating the public, sharing innovation, 

promoting progress and fostering cooperation” (Paragraph 1). According to Mike Thimmesch of 

Skyline (2009), Many companies choose to host or participate in Expos to raise awareness of the 

brand or company, present products face to face, build relationships, develop new markets, and 

to see what their competitors are doing. WorkWise, LLC (2016) states that face-to-face 

interactions are arguably the most powerful way to establish important relationships and 

demonstrate trust and reliability. This is why many businesses and organizations host expos, 

fairs, conferences, and fundraisers. Hosting these types of events requires a large amount of 
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preparation to create a successful event that can meet their goals. In this section, we will provide 

some of the most important characteristics to know about when hosting these events. 

2.2.1 Audience 
 Identifying the target audience and what type of setting the event should use is crucial to 

how the audience takes in the information (Linden & Creighton, 2008). Some events could have 

an open area with vendors along the perimeter of the space, which is very common for fairs, 

festivals and galleries. This allows the attendees to explore what is available to them and give 

them the choice to visit whichever vendors pique their interest. Although the attendees may not 

go to all of the vendors, they have a strong preference for which vendors that they want to go to. 

A different approach would be having vendors in different sections of a venue with the 

audience receiving a vendor schedule (Attard, 2016). This forces the audience to visit each 

vendor, which is advantageous to the vendors, but the audience might not be interested in 

visiting all vendors. The audience does obtain more information on all of the vendors, but if the 

schedule gives the vendors a short amount of time per session, then the audience may not have a 

complete understanding of each vendor’s product and its strengths and capabilities. A mix of 

both organizational types can be seen at conventions and does work fairly well; however, this 

can be more expensive and needs a larger venue with more vendors.  Ultimately, the 

coordinators of the event should be able to determine what type of audience setting is needed for 

the event being hosted. 

Certain styles of education might work better with some audiences than others. An 

example of this would be the difference between the Assistive Technology Program (2016) 

hosted in Sudbury, MA, compared with the Assistive Technology Fair (Hrin, 2016) at Penn 
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State. The Program in Sudbury was open to the public and had the audience sit down while 

speakers presented different assistive technologies to them. The Fair at Penn State focused more 

on an audience who would directly try out the technology, so they set up the venue to be more 

interactive than in Sudbury. Next to each technology booth was a technician ready to explain 

how to use each technology one-on-one with the user. The Expo at Clarkson University (2016) 

targeted special educators, therapists, administrators, disability advocates, service providers, 

family members and individuals with disabilities. The Expo was the most effective at targeting a 

large audience because of the various styles of education within the Expo; these styles included 

those at Penn State and Sudbury plus keynote speakers and a larger venue. 

2.2.2 Vendors 
Another important detail that needs to be considered are the vendors for the event. The 

vendors should contribute to the event itself, whether it be with food and water or a technology 

to display (Woodward, 2017). It would be out of place to have a vendor that does not fit into the 

overall theme of the event.  

Vendors generally want to sell a product at most events, but according to Yaniv Masjedi, 

VP of Marketing at Nextiva (2013),  sometimes a vendor could be asked to display their business 

or product to gain publicity or recognition. Vendors could display their products, give a brief 

description in a gallery or workshop setting, and possibly sell the products. The coordinators 

would decide this based on what outcomes they wanted from the event (Woodward, 2017). This 

might involve a compromise with what the vendor might counter-request. There are certain 

situations where selling a product might disturb the flow of the Expo, for example, if the Expo is 

tightly scheduled with workshops and information sessions. 
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Vendors at an AT Expo would be the companies or organizations behind each technology 

displayed. The vendors at every event all have the same role, which is to present their technology 

and explain how it works, its benefits and features. At the Low Vision Faculty Host Conference, 

vendors provided information on low vision evaluations to determine which technology would 

be best for the user (Hoogendoorn, 2016). The vendors also discussed insurance coverage for 

each technology presented. At the Assistive Technology Expo at UMass Medical School (2016) 

in Worcester, MA, vendors provided full demonstrations as well as information for doctors, 

patients, family members and students. If the event had breakout sessions like the Assistive 

Technology Expo at Clarkson University (2016), vendors would  be able to speak more in detail 

during their session. The more time a vendor has to talk about their technology, the more 

information that can be provided to the audience. 

Seven Hills Foundation staff have also commented on how technology today is far more 

flexible than in the past (Jean Des Roches, 2016). Today, thanks to competition and advances in 

technology, vendors competitively offer products that provide less expensive alternatives than 

others.  For example, Seven Hills heavily referenced the Amazon Echo as a viable and cheaper 

alternative to Smart Homes, a newly emerging trend among AT consumers.  

Vendors should also be initially separated into categories based on what disabilities their 

technologies serve (Planetizen, 2016). Taking this approach would not only attract a broader 

audience with varying needs, but it would also allow the audience and staff to compare devices 

 and make their own judgments of each vendor’s devices relative to other vendors.  

 

2.2.3 Speakers 
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There are different types of speakers who could be needed for any type of event (Talent, 

2015). For example, A Master of Ceremonies, or MC, controls the general event and the filler 

speaking portions such as welcoming remarks, introductions of speakers, and announcing breaks 

and transition times. If the event is mainly a showcase with constant speakers or special shows 

on one stage, an MC would be necessary.  

Keynote speakers (Hourigan, 2016) are the most important speakers at an event.  This 

speaker is the one who draws the whole event together and reveals why the event came to be by 

addressing any problems or ideas that would have sparked the need for the event (Talent, 2015). 

Keynote speakers are typically the most expensive speaker as they have a lot of background 

knowledge on the subject of the event and are usually well known for their work on the subject. 

Keynote speakers require strong communication skills so that they can capture the public’s 

attention within a short period of time while being able to touch upon every point that is 

necessary for the event. 

According to Mike Hourigan (2016), a professional keynote speaker, another type of 

speaker is one that usually comes along as a vendor and speaks about their product, if requested. 

 These vendor representatives would give a short or long presentation depending on how much 

time is set in the schedule for the vendor. Typically, at Expos there would be multiple vendors 

speaking simultaneously in different locations to give the public a more flexible approach to the 

vendors and the information that is important to each attendee.  

Speakers can be a principal part of an event if the goal is to inform the audience about the 

importance of AT. for example (Talent, 2015). Speakers could be the main attraction of the 

whole program and not only control the flow of the event but also inform, educate or inspire the 
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audience in a certain way. The Assistive Technology Expo at Clarkson University (2016) was a 

two-day event with multiple speakers, and a keynote presentation having a special keynote 

speaker, Therese Willkomm, Director of ATinNH. However, a keynote speaker is not necessary 

at all events. The Assistive Technology Expo at UMass Medical School (2016) did not have a 

keynote speaker but did have multiple speakers for different assistive technologies related to 

autism, stroke, and aging. The Low Vision Faculty Host Conference also boasted having 

multiple speakers that all gave information on many different types of AT for the visually 

impaired without requiring a keynote speaker (Hourigan, 2016). 

 

 

2.2.4 Incentivization  

According to Harold Stolovich (2010), properly constructed incentive programs can 

increase performance by as much as 44 percent. Setting an incentive may engage participants 

more, thus improving the performance of the desired outcome. An incentive program would need 

to be planned thoroughly in order to fit the problem’s needs (Stolovich, 2010). Adam Ramshaw 

of Genroe (2015) has explained a few different incentive plans that are used in events. One such 

incentive is a lottery. A lottery incentive is when participants receive a chance to win a prize by 

completing a certain task. This approach might be more difficult as it requires registration. If the 

task requires the participant to register, though, the impact is almost the same as conditional 

fixed payment (2015). This is also confirmed by a trial run by Health Services Research (2011). 
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Table (2) .  Health Services Research survey results (Halpern, Kohn, Dornbrand-Lo, Metkus, 

Asch, Volpp, 2011, pg 1669). 

2.2.5 Biotech Vendor Product Show 
We visited one such Expo at WPI Gateway Park in early January, the Biotech Vendor 

Product Show. Professor Kasouf notified us of this Expo through an email flyer that he received. 

This Expo was spread around the main floor lobby with vendors lining the perimeter of the 

room. We visited this expo to get a first hand experience of an expo, and to also gather 

information about how an expo is coordinated. We spoke to many vendors and coordinators who 

gave us some insight into the duration of planning the event. Vendors have told us of 

applications or requests ranging from 1-8 months, sometimes longer.  For this specific expo, 

companies applied to be vendors four months in advance of the actual date. This expo also did 

not seem lacking or empty without a speaker. 

 

2.3 Assistive Technology Organizations  

Seven Hills Foundation, Inc. (2016e) is the parent organization that anchors eleven 

individually operating affiliates. They provide the functions of business, human resources, 

facilities maintenance, information technology, construction, marketing, communications, 

 



29 

fundraising, and the Office of the President. Each affiliate organization is a separate 501(c) 3 

non-profit, which is led by an Executive Vice President. Although Seven Hills Foundation 

encompasses all of these organizations, only a few actually work primarily with individuals with 

disabilities and assistive technology. For a complete list of affiliate organizations, please see 

Appendix B. We will now describe those affiliates that directly work with disabled individuals. 

One major affiliate organization is the Seven Hills ASPiRE! (2016c). ASPiRE! offers 

innovative and creative programming that provides opportunities for individuals with intellectual 

and developmental disabilities, autism, and brain injury to develop skills necessary to pursue 

interests in employment, recreation, and social interaction. Seven Hills designed the ASPiRE! 

model to help individuals enrich their lives, broaden core competencies, and enjoy a full range of 

activities while cultivating a network of community relationships.  All services are 

person-centered and promote community integration—helping each person optimize his or her 

personal, social, and vocational competency to live successfully in the community.  ASPiRE! 

Consistently hosts programs and workshops divided by age (child, teen and adult) to assist the 

participant’s integration into schools and the workforce by giving them the tools that they need 

to build the relationships necessary to succeed, depending on their specific life struggles. 

Seven Hills Community Services (SHCS) (2016b) supports individuals with disabilities 

to live in various residential arrangements. The goal of SCHS is to provide each individual with 

a comfortable, safe and beautiful home while keeping him or her closely connected to family 

members, friends and the community. SCHS has branched out to provide residential 

arrangements in more than 50 communities in Massachusetts to please their participants and also 

spread their influence to a larger area for their expanding services. 
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Seven Hills Family Services (SHFS) (2016b) offers a network of services to families and 

loved ones with disabilities to further expose them to social interaction, friendship, residential 

and day supports and personal achievement. SHFS hosts multiple programs including Shared 

Living and Adult Family Care, Sports, Recreation & Leisure, Respite, and much more to ensure 

that the people with disabilities are achieving the highest quality of life with and without their 

assistive technology. 

Seven Hills Rhode Island (SHRI) (2016b) supports more than 1,000 children and adults 

with various disabilities throughout Rhode Island. SHRI has a wide range of programs and 

services that include day habilitation, rehabilitation, behavioral health, workforce training, 

placement and support, and recreation. Through the use of AT, the staff are able to effectively 

change the lives of the individuals they serve so that they are able to become as independent as 

they can in their day to day lives. 

2.3.1 Similar Organizations 

Easter Seals (2016) is a very well-known organization that provides resources and 

services for people of all ages with disabilities. The services of Easter Seals are specifically 

designed to meet individual needs through a team of professionals who are ready to help on a 

one-to-one basis. They also welcome family members to participate in any programs to support 

the families and also provide important information to best help their loved ones.  

United Cerebral Palsy (UCP) (2016) is an organization that provides support services to 

individuals with a wide spectrum of disabilities aside from Cerebral Palsy. One of the more 

important services that they provide is  financial assistance. They provide financial support to 

any individual who fits the requirements and also the mission of ensuring a life without limits. 
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UCP focuses on advancing independence and productivity through their direct services and 

affiliate network. UCP has previously helped millions with disabilities reach their optimum life 

potential.  

Parents Helping Parents (PHP) (2016) is a nonprofit organization that directs their 

information and services to the parents of disabled individuals. PHP provides information, 

support services and multiple different training sessions for these families to build a supportive 

and motivational group for each other, and provides assistance with choosing the right AT as 

well as funding for eligible individuals. 

 

2.4 Summarization 

According to Hector Torres, “Biomedical engineering is expected to be the fastest 

growing occupation, with a whopping growth project of 72% between 2008 and 2018, according 

to the Bureau of Labor Statistics”(Torres, 2010, Paragraph 1). This is because biomedical 

engineering encompasses both technology and health care, two growing industries within the 

U.S. economy. With both of these industries constantly growing, AT is constantly released. 

Keeping up with this rapid pace is a challenge that organization such as Seven Hills Foundation 

faces.  A recent research team from Worcester Polytechnic Institute (WPI)  tried to solve this 

issue (Bingel, Cornwell, DiMilia, Meersman, & Ngoc, 2016). They created a database that 

allows for anyone with access to it to log in and search for almost any AT.  Once one finds the 

AT they are looking for, there is a link to more information about the device.  At the link there 

are photos, a description, and a hyperlink to a website where one can purchase that exact device. 

Although this has been very useful to SHF staff, it did not fully solve their problem. 
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Along with this, SHF (2016d) has tried to get their staff and the public educated on how 

to use AT through the use of many different events that anyone can attend. These events include 

workshops, clinics, family nights, support groups, educational events, family support on the go, 

and an education series.  All of these are ways in which SHF promotes their cause and tries to 

address their mission.  At some of these events, there are interactive learning sessions for anyone 

interested.  This gives the attendees the opportunity to learn how to operate different AT devices. 

 In the description of the events, SHF discusses the different disabilities that each event would 

cover so staff and the public can decide which events to attend.  SHF (2016a) holds these events 

multiple times every month, so this allows people to come when they want and not be forced to 

come because the event was only held once.  In order to let the public know when these events 

are, SHF uses social media pages, such as Facebook and Twitter.  SHF uses these pages not only 

for promoting events, but also promoting their cause to educate the public on the new AT 

devices that become available.  In doing so, the public and staff at SHF also have the information 

on when the events will take place where they can learn how to use new AT devices.  Although 

SHF is working hard to eliminate the problem of staying up-to-date on how to operate new AT 

devices, they have not fully solved it.  The learning events that they hold address this problem, 

but they have been looking for a more effective way to accomplish this. Holding an Expo may be 

one way to do this. In the next chapter we will describe how we went about helping SHF decide 

if an Expo is the best way to accomplish their goal. 
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3.0 Methodology  

This project had one central goal: to provide a means to keep Seven Hills’ staff, clients, 

and the general public informed about the latest developments in Assistive Technology while 

optimizing costs and offering points of interaction for attendees. The Seven Hills Foundation, 

for some time now (reference to Rhode Island SHF Expo), has decided that the best way to do 

this would be with an Expo showcasing various AT. An Expo in any field typically takes 12 to 

18 months to plan, so given a 7-week timeline working with Seven Hills, our objectives 

became to (1) help SHF plan and host a pilot Assistive Technology Expo at their Worcester 

location. This would provide insight into whether or not a future Expo might be successful 

based on our collective experience. And (2) to provide Seven Hills with database that housed 

information they could use to more effectively host future Expos. We decided to use a Google 

Site as our platform for the database. By using a Google Site, we were able to synchronize it 

with all of our surveys and other information hosted on Google Drive, to act as a hub for 

contact lists, planning documents, survey statistics and inferences, interview transcripts, cost 

analyses, and the like. 

To accomplish these objectives, we had four different sub-objectives that led to the Expo 

and its evaluation.  These objectives were establishing the scope of the Expo, determining vendor 

and speaker interest and availability, completing a cost analysis and logistical arrangements, 

and laying the foundation for potential future Expos.  
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Establishing the Scope of the Expo 

In order for a pilot Expo to successfully come together in the short time we had, we 

decided it would be best if the Expo were largely staffed and promoted within Seven Hills and 

by organizations that already had a working relationship with SHF locally.  Our team originally 

planned on identifying the disabilities or the AT that the Seven Hills Foundation worked with 

most frequently in order to dictate what and who would be featured in the Expo.  Since the 

reach of their organization is so vast and Seven Hills helps individuals with a wide range of 

disabilities, there was no shortlist of disabilities or Assistive Technologies that they worked 

with. Instead, we decided the Expo would be best organized if we found vendors that satisfied 

different broad categories of disabilities and their respective assistive solutions (i.e. sight, 

hearing, home automation, etc.). With this approach we were able to move forward in 

identifying vendors and organizations that met those criteria. We compiled contact information 

for all vendors with local offices who had a relationship with Seven Hills, and placed that 

information in our Google Site database. 

Finally, there was a promotional effort for the expo. Working with Seven Hills’ 

Development Department, we made drafts of fliers and banners to advertise the Expo using 

their approved image assets. Afterwards, Development’s graphic designer Peter Demko (see 

Appendix D) made finalized versions of our fliers and banners that matched Seven Hills’ 

media standards. These advertisements were dispersed by Development using Facebook, 

Instagram, Twitter, Constant Contact, and their smart televisions. We strategically placed fliers 

around the WPI Campus Center and spoke with professors and students at Worcester State 
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University, Clark University, and Worcester Polytechnic Institute who were affiliated with 

either Biology, Engineering, or Computer Science. The Development Department created an 

online portal for attendees to RSVP for the Expo, using software they have used in the past. 

Having attendees register through this portal provided us with a list of people who were 

interested in attending an AT-related event and might be again in the future. Having people 

RSVP for the event also gave us an indicator for how many gifts we should purchase to give to 

attendees upon entering the Expo. Based on our projected attendance, we decided that 200 

sling bags could cover expected attendees, and would not be cost prohibitive given our budget.  

We also decided that having a workshop at the Expo would offer a point of engagement 

for attendees, and would leave them with another item to take home to remember the Expo by. 

In keeping with the theme of the Expo, we decided that the workshop would teach attendees 

how to construct a low-cost, low-tech do-it-yourself(DIY) assistive device. That way any 

attendee could walk away with a piece of AT that they created, could appreciate, and perhaps 

even use themselves. Since the items were low cost, if an attendee discarded the item the loss 

would be minimal. Steve Kessler, the Seven Hills Foundation AT Specialist (see Appendix D) 

provided us with the book Assistive Technology Solutions in Minutes: Ordinary Items 

Extraordinary Solutions Book II by Therese Willkomm, PhD, ATP. ((REFERENCE)). Using 

this book we had several options for low cost, easy to construct items that could be featured in 

our workshop. We ultimately decided that creating a battery interrupter would be the best 

because people would be able to attach it to any consumer electronic device that used a battery, 

and the item was a real, working smart switch that someone with a disability might be able to 

use. In addition they were cost efficient-- enough materials for over  300 complete battery 
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interrupters was about $75. Since there were so many options for low cost and low tech DIY 

assistive devices, the book was also on display at one of the Expo stations for attendees to 

freely look through, in case they saw anything that might be of use to them or others. 

Establishing Vendor Attendance and Interest 

The Expo also had the intention of informing those within the AT community as to the 

latest innovations in Assistive Technology. To accomplish this, we identified common 

categories of disabilities with AT solutions, and sought out vendors and devices that could 

represent each category. 

In order to understand what vendors look for in an Expo, our team attended an Expo for 

Biology firms at the WPI Gateway Building, at the recommendation of Professor Chickery 

Kasouf. Each team member spent about a half hour talking to representatives about how many 

Expos they annually attend, turnaround time for deciding whether or not they would be able to 

attend an Expo, and any associated costs and benefits. The most often repeated message from 

this Expo was that vendors were typically booked in advance, and that if their schedule 

happened to be clear, depending on the Expo, a group might decide to attend an event that 

same day. With this in mind, we decided that we had to immediately move forward with 

reaching out to vendors given our very narrow timeline. 

The list of contact information for vendors that we created was already filtered on the 

criteria that they had some sort of working relationship to SHF and were local in some way. In 

addition, this list of vendors satisfied the broad categories of AT we had hoped to represent at 
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the Expo. We drafted one universal email introducing potential vendors to the Expo and 

requesting their attendance. Working with Seven Hills staff, we decided which vendors we 

should reach out to with this email, which vendors SHF should reach out to, and which vendors 

we could expect timely responses from. Having SHF staff contact vendors was meant to 

expedite response times, since an email coming from someone working at Seven Hills has a 

much lower chance of being ignored and the recipient would know it was official. Seven Hills 

staff had their own personal connections within the AT industry and would take full initiative 

in contacting those individuals. After eliciting a response, we would be copied into an email 

and take over further correspondence. 

While the Development Department was hosting an online portal for attendee 

registration, our team designed and hosted a portal on our Google Site for Seven Hills’ 

Superusers to choose which booths at the Expo they would like to staff (see Appendix M). This 

allowed volunteers to easily choose which session(s) they could work and what technology 

they were familiar with enough to demonstrate. Recording this information in our database will 

allow SHF to know which Superusers were familiar with which devices, and who might be 

interested in staffing a similar event  should they host an event in the future.  

Since the Expo was on a weekday, Seven Hills staff had to find coverage for their 

daytime obligations. Upper-level management supported the event and sent emails encouraging 

Superusers to staff the Expo and get coverage. Where possible, management did what they 

could in order to facilitate Superusers receiving this coverage. 

As vendors and Superuser volunteers began to confirm their attendance for the Expo, we 

added them to separate email aliases in order to push weekly updates every Friday via email. We 
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did this so that leading up to the Expo, we could create a consistent line of communication and 

have no one feeling left in the dark. 

Cost Analysis and Final Logistics 

As we planned the Expo, given that SHF’s own office space served as the venue all of 

the costs were within Seven Hills’ $2,000 budget, with costs totaling $1,333. In addition, there 

was the absorbed cost of the additional power draw for stations that needed it during the Expo. 

For a breakdown of all costs for hosting this Expo, categorized as food, giveaways, and 

signage, please see Appendix N. Being able to look back at the costs for this Expo will be 

valuable to Seven Hills, as they can use their judgement on which costs were and were not 

justified.  

Early in the project our team reached out to Seven Hills staff members Mike Kendrick 

and Ed Doucette (see Appendix D) in order to receive a floor plan of Seven Hills’ bingo hall. 

Our team then overlaid our thoughts for the Expo’s layout, stations, and our projected flow of 

attendees. Later in the project when the attending vendors were finalized, we used one of our 

weekly updates to ask vendors how much space they would need, if they needed a power 

source, and if they needed other special accommodations. This information directly affected 

the layout of the Expo. Once all vendors had sent their needs to us, we were able to make one 

final layout. We then worked with SHF’s marketing team in order to make a version of the 

layout that would be given to attendees upon entering the Expo (see Appendix K) so that they 

knew the location of vendors and what was happening in what spaces. This layout was a part 

of a larger pamphlet that was given to attendees at the door (see Appendix L) that had more 
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information about the vendors in attendance. 

Final logistics then included creating signage to note entrances, exits, bathrooms, 

curbside foam signs, and wordcloud banners for the venue, ordering table cloths, and making 

table-tents to mark vendor tables. The cost for all signage was $44, plus an additional $8 so 

that every table had a table cloth. We pushed weekly vendor updates every Friday so that 

vendors were constantly aware of the status of the Expo and could reach out to us at any time 

with questions or concerns. 

Laying the Foundation for Future Expos 

Lastly, our team provided the Seven Hills Foundation with attendee feedback about the 

Expo, since this was a pilot event and feedback would determine the potential for future events. 

Team members had rotational positions during the Expo and asked participants questions to 

understand where the Expo had succeeded, where it may have fallen short, and how it could be 

improved. Drawing on our experience talking to vendors at the Gateway WPI Expo earlier in 

the term, and using metrics such as comparing registered versus actual attendees, average time 

spent at the Expo, and asking individuals how engaged they were and how much they learned 

from the Expo, we offered a variety of criteria that might indicate whether or not this Expo was 

a success. Additionally, we each took time to participate in the Expo ourselves to experience 

and critique the event ourselves.  

We also  used iPads provided by Apple and Seven Hills to host an exit survey (see 

Appendix E). We chose iPads since they offer a fast, user friendly interface. In this survey we 

asked attendees if they were willing to answer more of our questions in the future. If they 
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agreed, their information was recorded and placed in our database. We then contacted 13 

individuals who were willing to offer more of their opinions via email. In this email, we 

thanked them for their participation and made it clear that the Expo was a pilot event. In this 

email was a link to questionnaire with six short answer questions asking why they attended the 

event, and how we future Expos could be better. We let respondents know that their feedback 

regardless was very appreciated, but they did not need to feel pressured to answer all of our 

questions. Like everything else, this information was also turned over to Seven Hills in the 

website database we made for them. 

Finally, we conducted a brief meeting with two members of the Seven Hills Expo 

Team. In this meeting we recapped the site’s features, and provided additional insight into 

changes in its contents after the Expo. In addition, we provided a manual on how to use and 

edit the site, all of its contents, and everything we produced (such as surveys and sign up 

forms) so that anyone on the staff could use them themselves. 

Throughout our project our team successfully hosted an Expo that was open to the public 

and SHF staff, and turned over a database to Seven Hills that will allow the planning of future 

Expos to be more streamlined. This was made possible by working closely with Seven Hills’ 

Development and Marketing teams, in order to make sure that the rollout of this Expo was in line 

with their standards. Our team researched past Expos and trade shows, and drew on those events 

and the experience of SHF staff who had been involved in creating or attending Expos in the 

past. Our methods hinged on engaging all parties involved, and constantly updating them. 

Though the Expo was an enjoyable event with high vendor and attendee turnout, especially given 

its timeline, the question of whether or not an Expo was the best  solution given its costs still 

 



41 

remains. We will discuss these and other results in the following chapter. 
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4.0 Results & Analysis 

Our project’s goal was to provide the Seven Hills Foundation with a means to inform the 

general public, their clients, and their staff as to the latest happenings and offerings in Assistive 

Technology. To do so, our project team followed a course of methods detailed in the previous 

chapter and worked very closely with SHF staff. Though the execution of our methods did result 

in a timely event hosting attendees and vendors, there are actions we could have performed 

differently in retrospect and  the success of this event is yet to be discussed. 

In this chapter we will discuss the results of the Expo, the uses of the database, results of 

surveys from the vendors, staff, and attendees, and all Expo planning results. Afterward, we will 

offer our recommendations based on those from attendees, vendors, and the Expo Teams. Should 

Seven Hills decide to host another AT event, these results and our recommendations should 

make for an event that is even more well received. 

 

4.1 Expo Planning Results 

The planning process for this Expo was a constant decision-making process. Working 

with Seven Hills, we narrowed our options and were able to arrive at decisions on a range of the 

Expo’s components. In this chapter, we will discuss the results of choices concerning 

advertisement, speakers and vendors, the Expo’s layout, attendee registration, and volunteering. 

Each had many proposed options that changed over the course of our project before taking their 

final forms. 
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4.1.1 Contacting Potential Vendors 

After compiling a large list of potential vendors, SHF staff informed us that the Expo 

should represent a wide variety of AT. We filtered the extensive list of vendors we had already 

identified based on two criteria. First, we decided that the most productive way to group vendors 

would be based on what assistive solutions they could provide-- such as home automation 

devices, solutions for the sight or hearing impaired, devices for motor impairments, etc. This left 

us with a batch of vendors whose attendance would appeal to a wide audience; whether it be a 

SHF staff member,  someone seeking a new device, or a casual attendee. Second, we opted for 

vendors by choosing only those who already had an existing relationship with SHF. Together 

these criteria led to the creation of a shortlist of vendors to contact for the Expo. In the process of 

reaching out to potential vendors, we sent emails to the companies we had identified on our 

shortlist, beginning on January 25th.  

Our decision to only reach out to companies that the Seven Hills Foundation already had 

a relationship with resulted in fast responses, with Perkins School for the Blind confirming their 

attendance on that same day. Within one week, all 11 vendors that we reached out sent us a firm 

response, with the last being Kurzweil on February 1st. With four weeks’ notice, only one 

vendor (UMass Lowell) was unable to attend our Expo, but they were still interested in the event 

and decided to come as an attendee.  

 

 

4.1.2 Speaker Decision 

In the original planning process, we had planned for there to be a keynote speaker, Jared 
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Grier of the Grier Strong Foundation. We decided against it for two reasons. First, Jared is a 

full-time student at WPI and the date Expo created a conflict with his academic schedule. 

Secondly, we believed that introducing a speaker would create confusion and disturb the flow of 

attendees. In the extended survey we sent to attendees who were willing to answer more of our 

questions, when asked about the possibility of a future Expo, one respondent said “I like the drop 

in and and take your time approach.” The Expo also had one session that was high volume and 

one that was very low volume. Trying to rally attendees around a speaker could have proven 

difficult.  

 

4.1.3 Expo Registration Page 

After a meeting with Development, we discussed what information should be on their 

registration portal for attendees to RSVP for the Expo. We came to the conclusion that it would 

have first and last name, email address, how many guests they would be bringing, and which 

session they would be attending. This allowed us to calculate exactly how many people would be 

coming to each session of the Expo. Attendees could pre-register as many as 10 guests at a time, 

but only the person filling out the form had to include their information. As a result we were only 

able to capture that person’s information through this form. Sign in sheets were in place for at the 

Expo for both walk in attendees, and guests who had not registered themselves.  Using the online 

portal there were 92 pre-registered attendees the night before the Expo. 

 

4.1.4 Attendee Demographics 

After examining the results from the exit survey, we gathered various information 
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regarding the demographics of the attendees at the Expo. As per the graph below, we discovered 

that most attendees were Seven Hills staff, followed by the general public and family/friends. 

 

 

 

This shows that most of the attendees were Seven Hills staff. We also discovered that 

between all methods that development used to advertise the Expo, most attendees heard about 

the Expo through email. The fewest attendees heard about the Expo from social media. This 

shows that email was the best way to communicate the Expo.  
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4.1.5 Gathering Seven Hills Superuser Volunteers 

As we planned the Expo and what stations the SHF Superusers would have, we needed to 

find out which Superusers had more experience with certain devices so we could request them 

for those stations. To do so, we designed and hosted a portal on our Google Site for Seven Hills’ 

Superusers to choose which booths at the Expo they would like to staff (see Appendix M). After 

collecting responses, we decided that the Superusers would staff stations for augmentative and 

alternative communication, assistive hearing, low-tech devices, the myGaze, smart home 

solutions, and a table dedicated to recruiting Superusers.  

Superusers were able to work stations at the Expo after receiving coverage from their 

usual obligations, which was encouraged by upper level management. Even so, we did not have 

volunteers for 3 stations in the afternoon. At two of the stations, the resident Superusers stayed 

longer than they had planned in order to fill the vacancy. The VP of Seven Hills ASPiRE!, Joe 

Realbuto was also in attendance. He was excited about an annual AT Expo, so it may be that 
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those seeking coverage for future events have more support or incentives from management. 

 

4.1.6 Gathering General Volunteers 

Along with the Superuser volunteers, we needed gather more volunteers to run stations 

such as the battery interrupter workshop, registration/check-in tables, and to have individuals on 

standby for general help. We requested any Seven Hills staff available volunteer at the Expo, 

especially for the breakdown of the Bingo Hall. After several days, we only had a handful of 

SHF staff who were able to volunteer, so we decided to try to find volunteers from elsewhere. 

Chau told us that her organization, the Southeast Asian Coalition (SEAC), had many volunteers 

available that needed volunteer hours for various reasons and were willing to help. After 

contacting them, we received confirmation from 18 volunteers that were willing to come to the 

Expo for general help. They were placed at the registration/check-in station, the battery 

interrupter workshop, and also in the hallways to direct people into the Expo.  

4.1.7 Expo Layout 

After confirming how many vendors would be in attendance and how many needed to be 

connected to a power source (the only limiting factor in determining a layout) we began creating 

mock layouts for the Expo. As we gathered this information from vendors and began to have 

more pre-registered attendees, the proposed layout continuously changed. Once this was 

finalized, we sent our designs to SHF’s Development Department so that they could incorporate 

it into a handout for attendees. This allowed attendees to find out what vendors were at the Expo 

and where they were located so that they could go to the stations they were most interested in. 

Upon entering the Expo, many attendees looked at the Expo map and planned their time based 
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on which vendors or products they were most interested in. One attendee was even able to find a 

product that her son used to use, but had broken, saying “They had a tool that my son used to use 

but that got broken--flexible rubber strap that wraps around hand and can assist him in holding 

marker or pens in place so he can manipulate them. I haven't been able to locate these to order 

more so I was able to get that info.” 

 

 

 

 

 

 

 

 

All in all, all respondents to our exit surveys ‘agreed’ or ‘strongly agreed’ that the Expo was well 

organized, and its layout was easy to follow. We also placed the tables with wheelchair clearance 

in mind, and a notable amount of attendees were wheelchair bound. 
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During the Expo, we noticed an issue with the location of our exit survey table. We 

wanted the table to be placed such that all attendees would pass it on the way out. However, 

there was a gap between the snacks and beverages table where attendees could unknowingly 

bypass exit survey and leave. This meant that we missed many opportunities for feedback. We 

solved the problem temporarily by moving garbage cans there so attendees could not walk 

behind the exit survey, and began to see more responses. We also did not take those with special 

needs into full consideration when designing our exit surveys, and only received one response 

from a person who receives care from Seven Hills.  

 

4.2 Expo Results 

During the Expo, we informally spoke to vendors, attendees, and staff and asked them 

various questions about the Expo. We also asked attendees to complete exit surveys. A number 

of them were genuinely interested in submitting further feedback and were willing to follow up 

with us to answer even more questions about the Expo. We also sent a post-Expo survey to all 

participant vendors. Their responses will be explained in detail in the following sections. 

 

4.2.1 Expo Attendee Outlook 

In addition to the exit survey we had at the Expo, we sent out more questions to 

individuals who said they would be interested in answering further questions. These individuals 

felt strongly about our Expo, and wanted their feedback to be taken into consideration for future 

events. Even so, we were able to draw many conclusions from our standard survey as well. 

One notable attendee was Judy Fask, who is a transition rehab specialist for Worcester 
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Public Schools and a professor at the College of the Holy Cross. She came and extremely 

enjoyed the Expo as she works with individuals with disabilities and has been a exhibitor at 

previous events and Expos. After speaking with her, she offered us a range of feedback about our 

Expo. In addition she offered recommendations that will be discussed in Chapter 5. 

Another notable attendee was a mother whose son has severe cognitive disabilities and 

receives care at a Seven Hills facility in Groton, Massachusetts. She brought him with her to the 

afternoon session. She went to each station with her son and was thoroughly interested in 

learning about the latest offerings from each organization. We had a conversation with her while 

she was completing our Exit Survey. She felt that for her  needs, being able to speak with vendors 

individually and at length was a better experience than the heavily active, full Expo that 

attendees experienced in the previous session. In thePost Expo Attendee survey (see Appendix 

E), she explained, “My son doesn't understand instructions but they had everything set up so he 

could link up to [the myGaze] software and I could see that, with some help, it might work for 

him.” In addition to this case, there were a number of attendees who found themselves more 

attracted to the booths that were interactive.  

Our exit surveys asked attendees how they felt about the Expo’s layout, how well it was 

organization, how much they felt they had learned, if they enjoyed themselves, the length of their 

stay, and if they would come to another Seven Hills Expo. Their options ranged from ‘Strongly 

Agree’ to ‘Strongly Disagree.’ When asking questions about the Expo’s execution, there were no 

negative responses. The next page contains all of the survey compiled between sessions. 
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The first graph is in regards to what time the attendees arrived and how long their 

duration of stay was. The first Expo session went from 10 AM to 2 PM, and the second from 

3PM to 7PM. We found that most attendees arrived within the first hour of the Expo and stayed 

for about an hour to two hours. Over 10 attendees arrived before the Expo had opened, and at its 

peak, there were well over 100 attendees on the Expo floor at one time. This foot traffic was 

sustained for about 90 minutes. 

This next pie chart displays how much the attendees felt they had learned about AT from 

coming to the Expo. 
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After reviewing the answers for this question, over half of the attendees strongly agreed that they 

learned a lot about Assistive Technology, and 97% answered that they had learned a lot about 

Assistive Technology from this Expo. 

The following graph offers insight into how much the attendees enjoyed the Expo. 

 

Looking back at the responses we received, every respondent felt that they enjoyed themselves at 

the Expo.  

One of the more important questions we asked was if the respondent would be willing to 

attend future Expos hosted by the Seven Hills Foundation. 
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97% of the attendees who completed our Exit Survey would come to future Expo at Seven Hills. 

Since this was a pilot event, this is a direct indicator of the potential success rate for future 

Expos. 

 

4.2.2 Expo Vendor Outlook 

While we were talking to the attendees, we also spoke with vendors to better understand 

how they felt about the Expo throughout the day. Every vendor was excited to be at the Expo and 

enjoyed working with attendees who were genuinely in AT and what the vendors had to offer. 

Multiple vendors approached us asking to be registered for next year’s Expo not knowing that 

the event was a pilot.  

The vendor representing REquipment, Roxy Rocker, stated that while discussing the 

Expo with her organization’s board and Massachusetts State Senator Harriette Chandler, her 

board was thrilled to be a part of the Expo. Senator Chandler was also very excited about the 

event and remarked that AT-oriented organizations should work more closely with WPI and its 

engineering programs. After the Expo, we sent a survey to all of the vendors. The results are 

below.  

The graph below represents the vendors views for the expectations for the Expo.  

 

 

 

 

 



54 

 

 

 

 

 

Our Expo met or exceeded every vendor's expectations. This means that for a vendor who 

regularly participates in Expos, this event at least met their expectations for professionalism and 

execution.  Interestingly enough, more vendors said that their expectations were met rather than 

exceeded. This shows Seven Hills that though the Expo is unanimously supported, it can be 

improved upon. We believe this is in part due to the long sessions with significant downtime. But 

as articulated by the representative for Perkins School for the Blind, Erin Fragola, oftentimes 

Expos are exclusively downtime and attendees are uninterested. With shorter sessions, vendors 

would have had to plan to obligate less of their time, and would have been able to enjoy constant 

high-energy foot traffic, which was the case for the first 90 minutes of the morning session. Even 

so, attendees and vendors enjoyed being able to spend more time with attendees to have more 

intimate conversations.  

The next graph displays the responses from the vendors in regards to how well the Expo 

was executed on a scale of 1 to 10. A 10 means the Expo was perfect, a 1 means the Expo was 

extremely poor. 
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All vendors had responded with at least a 7. There were a few 10’s, but most vendors felt the 

execution deserved an 8. This information is valuable as it was a pilot event and it shows that 

Seven Hills’ Expo came together well. 

The final question we asked was whether or not the vendors would come to another event 

at Seven Hills. 
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This shows that all of the vendors would be interested in coming to future events held by Seven 

Hills. In future events, these vendors will be the advocates who push for participation. For Seven 

Hills they can be seen reliable and immediate go-to contacts. 

 

4.2.3 Expo Staff and Volunteer Views 

We had three sources for volunteers: Seven Hills Superusers, Seven Hills staff, and 

volunteers from SEAC. As these individuals had different roles and perspectives; both among 

one another and compared to vendors or attendees, we considered their input valuable and one 

that should be surveyed independent of other groups. Volunteers from the Seven Hills 

Foundation mostly demoed devices, helped facilitate the Expo, and helped with the snacks and 

beverages. The SEAC volunteers helped register attendees, staffed the battery interrupter 

workshop, and guided the attendees through the Expo when necessary. After the Expo we sent a 

survey to the all volunteers to get their feedback. Below are their responses. 

The first question asked what the respondent what they identified as.  
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Knowing how many respondents came from each organization should be taken into 

consideration when interpreting the results to later survey questions. 

Our next question asked respondents whether or not the Expo exceeded their 

expectations. The survey was programmed so that only SHF Superusers and SHF volunteers 

were able to answer this question. 

 

 

 

More than ¾ of Seven Hills’ own volunteers felt the Expo exceeded their expectations. Since this 

was a pilot event, it is important to quantify whether or not participants (especially SHF staff 

who might help host the event in the future) felt the event came off as a legitimate Expo that 

represents Seven Hills’ potential. 

The following graphic represents how well volunteers felt the Expo was executed on a 

scale of 1 to 10. This question was asked to all volunteers. 
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As the data shows, there were responses ranged from 5 to 10. 94% of respondents rated the 

Expo’s execution as a 7 or higher, so one might consider the score of 5 to be an outlier. Even so, 

it should be taken into consideration and is a reminder that there is room for improvement 

despite the Expo widely being well received.  

 

Finally, we asked all of the volunteers if they would be interested in volunteering for a future 

event or Expo with Seven Hills. 
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Every volunteer said they would come back to another event or Expo held by Seven Hills. This 

shows Seven Hills that they have support for volunteering in the future. 

After gathering all of this data, Seven Hills can see that they have support from every 

party involved in the Expo. Given that the response was largely positive across groups 

(attendees, vendors, and volunteers internal and external to SHF), Seven Hills may largely 

consider this event’s participants to be reliable partners, as these groups consistently agreed that 

they wanted be a part of future events. 

 

4.2.4 Expo Cost Analysis 

There were a number of costs associated with hosting this Expo including food, 

beverages, giveaways, and signage. Additionally, Seven Hills absorbed the cost of electricity for 

stations that needed power during the Expo, and the cost to have SHF staff at the Expo rather 

than usual jobs. Besides the latter two costs, all others have been quantified in the following 
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spreadsheet (Appendix N): 

 

This spreadsheet shows the cost and quantity for everything purchased for the Expo, and 

how many were actually used. The sum in the first column represents the amount Seven Hills 

paid to host this Expo, $1,333. The second column sums costs if we had purchased the exact 

amount of materials needed for this Expo. Seven Hills’ budget for this event was $2,000, so the 

event came $667 under budget. Notably, we only used half of the sling bags (100) and we 

purchased enough materials to make nearly 200 more  battery interrupters. There were also about 

4 extra trays of pastries and cookies by the end of the event. However, incentivizing the exit 

survey with giveaway bags did draw attendees’ attention and helped solicit responses. 

Considering this was a pilot event, anything that might help draw additional feedback is 

worthwhile. 

4.3 Database Results 
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The database was created to house all information and assets that led to the execution of 

the Expo. Doing so means that Seven Hills will be able to conveniently reference, use, and edit 

any surveys, statistics, feedback, contact sheets, signage, or other materials that became a part of 

the Expo. Providing all of this in one package will make for a more streamlined execution of 

future events.  

We created a manual for this database so that any present or future SHF staff member can 

operate or edit the site or any document/file within the database. So, for example, should Seven 

Hills decide to re-use one of our surveys they can readily find any questionnaire that we used, 

and if they would like to edit it, we have provided them with the administrator rights and a guide 

to do so.  

We designed this database to be user friendly by creating it on Google. Meaning that 

should troubleshooting be necessary in the future and not explained in our manual, there will be 

ample resources available through Google’s own guides to help Seven Hills. Further,  any time 

the site’s operators would like to create something new for the database, the Google Drive 

platform can sync files instantaneously across multiple platforms-- including the database.  

After a brief meeting with two members of the SHF Expo Team, they agreed that the 

database was user friendly. At the end of our project we handed over administrator rights to any 

staff willing to take them, giving Seven Hills complete and total access to every single file we 

created, ranging from surveys to survey statistics to contact sheets and registration forms. 

Reusing the files we made for this event in the future will certainly reduce the time it takes to 

rollout future events. 
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5.0 Recommendations & Conclusions 

5.1 Recommendations Concerning Attendees 

After hosting this Expo, our team realized there were a number of perspectives that we 

we did not take into consideration during our planning process. In this section, we will offer the 

Seven Hills Foundation additional insight into what those attendees sought from the Expo, and 

how to go about creating an event that best includes them. 

 

5.1.1 Individuals with Disabilities  

There were many individuals in attendance with with a range of disabilities. Even though 

this Expo was designed to showcase products that are specifically for those with disabilities, 

those individuals were not able to fully participate in the Expo. Partially because some stations 

offered literature instead of demoing devices, asking vendors to create stations that are accessible 

does pose a challenge. However, given that the Seven Hills Foundation attracts individuals with 

a wide range of disabilities, it would be fitting if they were able to either demo devices or more 

intimately interact with the devices that might assist them. 

Additionally, our team did not design an exit survey that was fully accessible. Since this 

event drew so many individuals with disabilities, our team believes it would be important to 

capture as many of their feelings about this event as possible. To do this, we recommend 

continuing the use of iPad based exit surveys as practiced in the pilot Expo. But in addition, a 

staff member could have an iPad with several short answer questions that they ask an attendee. 

The volunteer could then record a person’s responses, allowing anyone to be able to offer 
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feedback.  

 

5.1.2 Caretakers Accompanying Individuals 

Likewise in attendance were caretakers who would bring several individuals along with 

them for a day trip. These individuals receive care in the same facilities, often on a daily basis. 

It’s easy to understand how a change of scenery might be exciting for them (say, a day at the 

park), but to attend an event that is designed for  them is a rare occurrence. Keeping these 

individuals in mind, our team can only further emphasize how important it is to eventually 

design an event that offers points of engagement and interaction for these individuals 

specifically. Offering a means for them to participate in the Expo and demo devices that was also 

“fun” would make for an outing that they looked forward to. It certainly would not be easy to 

make every vendor’s booth accessible for attendees; however, we believe that doing so would be 

a core differentiator for Expos hosted by Seven Hills. The caretakers are highly professional, but 

at times the individuals they were accompanying would roam or try to find something to do-- 

again, probably due to the limited points of engagement.  

 

5.1.3 Those in the Market for an Assistive Device 

There were a number of attendees who were parents seeking devices that could help their 

children. These attendees often scanned the list of vendors participating, and chose what tables 

they would visit based on what their child needed. Multiple vendors reported that attendees were 

interested in purchasing devices or enrolling in their organizations on the spot (notably the 

myGaze). We recommend that in the future, vendors be asked to be prepared to offer attendees 
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information on where they might purchase a device, whether or not they can expect to use their 

insurance, and if there are any organizations that commonly assist individuals in affording their 

device. Given the high volume of the morning Expo session, we recommend that vendors offer 

this information in the form of handouts so that they can quickly distribute the information 

without needing to take the time to explain it to each attendee. 

We further recommend that Seven Hills looks into hosting organizations that offer 

funding for individuals with disabilities (federal or otherwise), or connects individuals with the 

AT that they need. 

 

5.2 Recommendations Concerning Staff 

Though the Expo did ultimately come together, table staffing namely occurred on a 

volunteer basis. The fact also remains that some tables did not have an SHF Superuser volunteer 

to staff them in the afternoon session. Further, we believe that there are roles SHF staff or 

management could assume during future Expos that would allow them to benefit more from 

these events. 

 

5.2.1 Allocating Staff Members 

Several tables at the Expo were worked by SHF staff and Superusers. However, to do so 

they first needed to receive coverage from another staff member, and the go ahead from upper 

level management. In order to facilitate this process the Seven Hills Expo Team made upper 

level management aware of the event, who, in turn, supported it and those who sought to staff it. 

Even so, there were still tables without SHF volunteers to staff them in the afternoon. 
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In attendance in the morning session was the Vice President of Seven Hills ASPiRE!, Joe 

Realbuto. He was ecstatic about the event and believed it to be a resounding success in terms of 

turnout and content. Given total attendance was approximately 200 people for an event that was 

planned and hosted in 5 weeks, and given that upper level management was in attendance and 

supported the event, we recommend that Seven Hills seeks firmer support from them for future 

events. With 90.5% of exit survey respondents saying they would attend another event, there is 

clear demand for future AT Expos. This means that there should at least be sufficient SHF staff 

members to attend to tables that had a volunteer in a previous session.  

 

5.2.2 Networking and Relationships 

This event was able to come together on such short notice in part due to leveraging 

relationships that already existed between SHF and other organizations. It would be in Seven 

Hills’ interest to continue fostering these relationships (specifically with the Expo 

representatives), as they will most likely be the advocates for future attendance. For Seven Hills 

to make itself available to additional networking at these events would allow for a direct line of 

communication with other organizations. Having these personal contacts bypasses the nuance of 

sifting through layers of management whenever they might want to cooperate with another 

organization. Instead, they could simply go through the representative who attended the Expo. 

Creating a pool of such contacts (beginning with those that were in attendance at the 2017 AT 

Expo) would result in a large group of individuals who represented AT-oriented organizations, 

and would advocate for cooperation with Seven Hills and participation in future Expos. 
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There were also a number of individuals who attended the Expo seeking to collaborate 

with Seven Hills, or to help facilitate future events. Our team recommends that there is an SHF 

staff member available to freely network and exchange contact information with these people. 

Since there was already a table dedicated to recruiting SuperUsers, this could perhaps take the 

form of a table where attendees with special interests could speak with a representative from 

SHF. At this table, they could leave their contact information and a copy of what they had hoped 

to do with Seven Hills. We believe this table would help create new, strong relationships. 

  

5.3 Recommendations Concerning the Expo & Costs 

Though attendees unanimously agreed that the Expo was well organized and its layout 

easy to follow, there are structural changes that can be made. Through these changes, we believe 

the result will be a more succinct and efficient Expo. Further, the resulting Expo would optimize 

participants’ time and also maximize the feedback Seven Hills receives.  

 

5.3.1 Time and Sessions 

Put simply, the Expo was too long. Two four hour sessions was excessive, and we 

learned that the vast majority of attendees came to the morning session. However, to suggest that 

two sessions was a bad idea would be shortsighted. For an event that took place on a weekday, it 

was only logical to assume that some people who might be interested would have work and other 

obligations by day. This turned out to be true: though significantly less in number, there were 

attendees in the evening who chose that session for the aforementioned or similar reasons. 

To address this, we recommend that Seven Hills hosts future events on weekends, and 
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that sessions are limited to two hours or two and a half hours. The morning session’s rush hour 

lasted for 1 hour and 26 minutes, with more attendees trickling in afterward. With a narrower 

window of time, foot traffic would be more constant. It is also worth taking into consideration 

that even though the morning session’s large attendance made it very exciting, some later 

attendees noted that they appreciated being able to take their time with vendors and have 

intimate conversations. Even though you cannot predict when people will arrive with total 

accuracy, we do suggest attempting to strike a balance between these two ideals.  

 

5.3.2 Capturing Feedback 

Attendees unanimously agreed that the Expo’s layout was easy to follow, and when 

surveyed, no vendors had complaints with their locations. However, when it comes to hosting a 

pilot event and its first successors, receiving feedback is of the utmost importance because it 

provides guidelines for changes that people want . Our approach for capturing this feedback was 

flawed in two ways. First, in the Expo’s layout (see Appendix K), there was a passageway that 

allowed for attendees to exit the Expo without passing by the exit survey booth (specifically, 

there was space between Perkins’ table and the tables dedicated to snacks and beverages). One 

should not expect to have 100% participation with an exit survey, nor should an exit survey be 

intrusive or impose upon the experience of attendees. However, in order to maximize 

respondents it would be helpful to place tables in such a way that attendees are guaranteed to 

pass it on their way out. Our solution was to place trash and recycling bins in that gap. Since the 

layout we used worked so well, we suggest Seven Hills considers using a similar fix. Secondly, 

some attendees entered the Expo using the doorway that led to the bathrooms. Until this was 
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addressed, several people came into the Expo without first signing in. Because of this, we lost 

the opportunity to capture their information on sign-in sheets and our headcounts are less 

accurate. To combat this, we suggest either signage or volunteers placed at that entrance 

directing people to sign in if they have not already pre-registered. 

Finally, we must again mention that our team did not design our exit surveys to be 

accessible. Though only one response to our surveys came from an individual receiving care 

from Seven Hills, we believe that being able to capture feedback from these individuals is 

important since this Expo is devoted entirely to products that would increase their quality of life. 

To accomplish this, our team suggests having a volunteer with an iPad with several simple, 

pre-written questions. The volunteer could ask an individual these questions, and record their 

responses. 

 

5.3.3 Costs 

For the most part, this Expo was a relatively low cost event with minimal waste. Our 

team would simply like to note that relative to the number of attendees, on this occasion there 

was a surplus of food (nearly 4 unused trays of pastries and cookies). This could be an 

opportunity for saving money.  

On the other hand, the incentivized exit survey was a big hit and grabbed the attention of 

many attendees who may not have otherwise been convinced to complete the exit survey. 

Oftentimes, people did  complete the exit survey out of a genuine desire to see this event grow 

and progress. Even so, attendees did like having an incentive. Our team recommends the 

continued incentivisation of exit surveys, whether it is a giveaway or an item every respondent 
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receives in order to generate the most feedback possible.  

 

5.4 Third Party Recommendations 

Throughout the Expo we spoke with many attendees and vendors. Some of them had 

good ideas and recommendations for our Expo and future events. Two notable examples of these 

individuals were Judy Fask of Worcester Public Schools and Roxy Rocker of REquipment. 

 

5.4.1 Judy Fask: Worcester Public Schools Transition Rehabilitation Specialist  

Attendee Judy Fask, Transition Rehabilitation Specialist for Worcester Public Schools 

and Holy Cross, had a valuable recommendation for vendor stations at the Expo. She 

recommended that individuals with disabilities who use the devices that a vendor is showcasing 

be present at each station to show others how they use the device. She recommended this 

because she’s had her own station at other Expos where this was the norm. 

 

5.4.2 Roxy Rocker: REquipment Representative 

The vendor representing REquipment at the AT Expo, Roxy Rocker, has suggested 

incorporating a drop off/donation program for those with AT that they no longer use. An 

attendee who could use one of these products could then freely check one out, and keep it. 

Decisions such as if there would be a cost and the implementation of this program would be up 

to Seven Hills and REquipment.  
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5.5 Conclusion 

All of our results and recommendations have been added to the database we have 

provided to SHF so that they can reference them at any time in the future. This information will 

allow Seven Hills to make decisions based on our collective experiences when planning any 

future event. Moreover, it will help them create events that offer more  of what their attendees 

and participating vendors would like to see. 

The purpose of the Expo was to bridge a knowledge gap among the Seven Hills staff and 

some of their clients. With an organization of SHF’s size (approximately 170 locations and 3,600 

employees), keeping all staff up to date with constantly changing and improving AT devices 

creates challenges. The purpose of conducting this pilot Expo was to offer insights into whether 

or not an Expo was the best option to strengthen the knowledge base their staff already has, and 

improve upon it. We recommend that the Seven Hills Foundation moves forward with hosting 

future Assistive Technology Expos. Nearly all exit survey respondents agreed with the statement 

that they learned more about AT after attending the Expo. This means that our event did 

successfully teach people more about Assistive Technology. However, we also recommend that 

Seven Hills at least considers continuing to host smaller Expos. Previous Expo attempts were 

larger, never got off the ground, and took considerable time to plan. On the other hand, this event 

came together in five weeks, had a fraction of the costs, and actually came to fruition. 
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Appendix A: Seven Hills Foundation Organization 
About Seven Hills Foundation 

Seven Hills Foundation (2016a) is one of the most dynamic and comprehensive health 

and human service agencies in the country. They provide comprehensive supports for people 

with significant life challenges and assists both children and adults who need medically intensive 

interventions who are supported with clinical expertise and compassion in the least restrictive 

environments. Also Seven Hills (2016a)  provides educational support and long-term future 

services to people with disabilities and other life challenges like poverty and trauma. Family 

members are trained to counsel, educate and empower their loved ones. Seven Hills (2016a) 

gives access to each person’s community of choice so that they feel supported and encouraged to 

live meaningful lives. They do so through their individual locations and staff that is comprised of 

over 3,600 employees at over 170 locations in 43 different countries who offer services to over 

45,000 individuals. 

 

Figure 1: Seven Hills Foundation 

Seven Hills Foundation (2016a) was established in 1951. Through the past sixty-five 

years the Seven Hills Foundation has grown a lot. They now report to have one hundred seventy 

locations in Massachusetts, Rhode Island, and abroad. In addition to that, Seven Hills has three 

thousand seven hundred professional employees who represent a proudly diverse forty-three 

different countries. Seven Hills provides support and services to over twenty-eight thousand 
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children and adults with disabilities and life challenges. Through eleven Affiliate organizations, 

Seven Hills Foundation is able to currently help seventeen thousand (not included in the 

twenty-eight thousand) women and children in developing countries . To continue this line of 

work and expand their services ever further beyond, Seven Hills performs closely to their 

Strategic Plan by remembering their Mission Statement that will help them carry on their vision 

(Background 2.2.1). 

 

Seven Hills Foundation Mission Statement & Vision 

The mission of Seven Hills Foundation (2016c) is to promote and encourage the 

empowerment of people with significant challenges so that each may pursue their highest 

possible degree of personal well-being and independence.  This mission gives Seven Hills a 

meaning behind every program or service provided so that the organization can reach their 

vision, which is “to be a preeminent leader and resource in the identification of unmet 

community needs; in the promotion of professional and compassionate models of service; and as 

an advocate of emerging public policy which exemplifies the dignity of all persons regardless of 

physical, social, or emotional condition.” (para. 3)  

 

 

Seven Hills Foundation Organization 

As one of the largest and most comprehensive health and human service agencies in the 

Northeast, Seven Hills Foundation (2016c)  and its eleven operating affiliates has a unique 

corporate structure that allows for seamless integration of supports and services. The 
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Organization is split into different sectors that allow an easier flow of information to and from 

the patients in the program and the president and directors of each program. Under the Board of 

Trustees and the President/CEO of Seven Hills Foundation comes the Executive Vice 

President/Chief Operations Officer and the Senior Vice President/Chief Program Officer. Both 

Vice Presidents have four sectors that they work closely with to ensure the successful operation 

of the whole Foundation.  

The Executive Vice President/Chief Operations Officer controls the Business Finance 

Group, Human Resources Group, Information Technology Group and the Facilities/Engineering 

Group. For our project, the first 3 groups are vital to our completion. The Business and Finance 

group are in charge of all funding for the staff, programs, utilities and community outreach. This 

group determines the amount of funding going into an event like the Expo. The Human 

Resources Group and Information Technology Group would have data and statistics on what 

technologies and practices work best and most efficiently for the foundation. 

The Senior Vice President/ Chief Program Manager controls the Child and Family 

services Cluster, Clinical and Behavioral Health Cluster, Community Supports Cluster and the 

Seven Hills Rhode Island Cluster. All of these clusters are very important to the nature of this 

project because each cluster provides assistance to people with Disabilities. These people that 

Seven Hills serve are one of the main target audiences that the Expo wants to focus on so that the 

Expo can allow these people to learn more about Assistive technology and the benefit of each. 

Seven Hills Foundation’s Organizational Chart (2016d) is provided on the following page. 
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Figure 2: Seven Hills Foundation Organizational Chart 

Seven Hills Foundation Disabilities 

Based on data from the American Community Survey (ACS), 12.7% of the 314.8 million 

civilians living in the community in the United States in 2013 had a disability. There are 

numerous assistive technologies for all kinds of minor or major disabilities that Seven Hills 
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could not possibly only have a handful of different disabilities that they serve. Autism (Autism 

Spectrum Disorder), delays and behavior concerns, language skills, cognitive skills, audial 

impairment, mental disorders and vision loss are some of the many types of struggles that a 

person with disabilities have. These same people walk into Seven Hills Foundation looking for 

assistance to ease their everyday life tasks. 
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Appendix B: Seven Hills Foundation Affiliates 

Seven Hills Foundation, Inc. is the parent non-profit organization that anchors eleven 

individual operating Affiliates. Seven Hills Foundation (2016b) provides the functions of 

business, human resources, facilities maintenance, information technology, construction, 

marketing, communications, fundraising, and the Office of the President. Each Affiliate 

organization is a separate 501 (c) 3 non-profit, which is led by a Vice President. 

 
Children's Aid & Family Service (CAFS) 

CAFS supports income-eligible families throughout Worcester County, MA, in their          

pursuit of successful life/work balance, providing day care, family child care, and Child Care              

Resources, which provides a single point of access for voucher child care in central MA. CAFS'                

Child Enrichment Center is a state-of-the-art facility located in Fitchburg, MA. CAFS' Family             

Day Care providers are located throughout central and north central MA. Both the Center and               

Family Day Care accept families through both voucher and private pay. 

 

Figure 3: Children's Aid & Family Service 

The International Center of Worcester (ICW) 

ICW designs professional and cultural programs for international visitors sponsored by           

local and foreign governmental and non-governmental agencies, private companies, universities          
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and individuals. ICW is part of a nationwide network of centers for international visitors that are                

members of Global Ties U.S. in Washington, D.C.  

 

Figure 4: International Center of Worcester 

Seven Hills Behavioral Health (SHBH) 

For more than 60 years, SHBH has been providing a path to a process of change through                

which people improve their overall sense of health and wellness. This is achieved by offering               

a wide array of mental health and substance abuse treatment, prevention, counseling, and            

educational services to support individuals, families, and communities. All of the SHBH          

programs are provided in English, Portuguese, and Spanish, and are customized to individuals’'             

needs in a supportive, caring environment. 

 

Figure 6: Seven Hills Behavior Health 

 
Seven Hills Global Outreach (SHGO) 

Seven Hills honors its employees who come to us from over 45 different countries, in               

part, by defining a culture of putting others first. Through the initiative of our diverse staff,                

SHGO was established to help people with significant life challenges across the globe. SHGO              
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leverages humanitarian efforts of partnering health, education, and human services organizations           

in developing nations and home communities of Seven Hills’ staff. 

 

Figure 9: Seven Hills Global Outreach 

Seven Hills NeuroCare, Inc. 

In 2014 Seven Hills launched its newest Affiliate, Seven Hills NeuroCare, Inc. to provide              

a significant focus in supporting individuals with brain injuries in both Massachusetts and Rhode              

Island. Seven Hills has supported the complex needs of individuals with brain injury for decades,               

both within our day supports as well as residentially. 

 

Figure 10: Seven Hills NeuroCare 

Seven Hills Pediatric Center (SHPC) 

SHPC is a Pediatric Skilled Nursing Community that provides long-term, continuous           

nursing care to children and young adults below a cognitive age of 12 months, short-term respite                

care to children and young adults below a cognitive age of 24 months, and sub-acute care to                 

children 18 years of age with no minimum/maximum cognitive age. SHPC also operates Seven              

Hills Academy at Groton, a private, on-site special needs school. 
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Figure 11: Seven Hills Pediatric Center 
 

Stetson School 

Stetson School is a nationally accredited, fully licensed, Chapter 766-approved          

Residential and Education Treatment Program for male youth and young adults, ages 9-22, with              

sexually problematic behaviors, complex developmental difficulties, chronic mental illness, and          

autism spectrum disorders, who have suffered from severe trauma. Recognized as a national             

leader in the treatment of sexually troubled behavior, Stetson School offers a continuum of              

supports and services to the high-risk population with a family-focused, individualized “culture            

of recovery.”  

 

Figure 13: Stentson School 

 
VSA Massachusetts 

VSA Massachusetts promotes the involvement of people of all abilities in the cultural life              

of our communities and is part of an international network of VSA organizations serving 35               

states and over 50 other countries. VSA is affiliated with The John F. Kennedy Center for the                 

Performing Arts in Washington, D.C. The letters VSA reflect the Vision of an inclusive              
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community, Strength in shared resources and Artistic expression that unite us all. 

 

Figure 14: VSA Massachusetts 
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Appendix C: Abbreviations 

SHF: Seven Hills Foundation 

AT:  Assistive Technology  

ATs:  Assistive Technologies 

WPI: Worcester Polytechnic Institute 

ILC: Independent Living Center 

IQP: Interactive Qualifying Project  

DME: Durable Medical Equipment  

ATRCs: Assistive Technology Resource Centers 

PHP: Parents Helping Parents  

UCP: United Cerebral Palsy  

SHRI: Seven Hills Rhode Island  

SHFS: Seven Hills Family Services  

SHCS: Seven Hills Community Services  

CEOD: Council on Equal Opportunity and Diversity 

MC: Master of Ceremony 

CLO: Chief Learning Officer 

MRC: Vocational Rehabilitation Program 

RSA: Rehabilitation Services Administration 

VR: Vocational Rehabilitation  

ILC: Independent Living Center  
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CIL: Centers for Independent Living 

SILC: Statewide Independent Living Councils  

CAFS: Children's Aid & Family Service  

ICW: The International Center of Worcester  

SHBH: Seven Hills Behavioral Health 

SHCS: Seven Hills Community Services  

SHFS: Seven Hills Family Services  

SHGO: Seven Hills Global Outreach  

SHPC: Seven Hills Pediatric Center  

SHRI: Seven Hills Rhode Island  

ACS: American Community Survey  

MATLP: Massachusetts Assistive Technology Loan Program 

SEAC: Southeast Asian Coalition 
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Appendix D: Seven Hills Expo Team Information 
Seven Hills Expo Team Information (SHF Staff) 

Name Job Title Office Location Email Phone 

Jean K. Des Roches 
 

(Project Sponsor) 

Assistive Technology (AT) 

Program Director 

Seven Hills Foundation 
 

81 Hope Ave.  
Worcester, MA 01609 

JDesRoches@sevenhills.org 774-633-5887 

Jonathan D'Amico Home Based  

Supports Coordinator 

Seven Hills RI 
Child and Family 
Services (North) 

JDamico@sevenhills.org 401-309-9975 

Elizabeth Vittum Assistant Vice 

President of 

Development 

Seven Hills Foundation 
 

81 Hope Ave.  
Worcester, MA 01609 

evittum@sevenhills.org 508-983-1306 

Kathleen A. 

Myshrall 

Vice President of 

Advancement 

Seven Hills Foundation 
 

81 Hope Ave.  
Worcester, MA 01609 

KMyshrall@sevenhills.org 508-983-1302 

 
Steven Kessler 

 
Assistive Technology (AT) 

Specialist 

 
Seven Hills Foundation 

 
81 Hope Ave.  

Worcester, MA 01609 

 
SKessler@sevenhills.org 

 
508-873-7816 

 
Peter Demko 

 
Multimedia Communications 

Associate 

 
Seven Hills Foundation 

81 Hope Ave.  
Worcester, MA 01609 

 

PDemko@sevenhills.org 

 
508-983-1307 

 
 
 

 
NOTE: Seven Hills Foundation (SHF), Corporate Office:  81 Hope Ave, Worcester, MA, 01603 
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Appendix E: Questionnaires, Surveys, & Interview Protocols 

E(1): Exit Surveys 

Afternoon Exit Survey 
Thank you for attending the AT Expo! As with the other surveys, this survey is completely optional and 
anonymous. We appreciate your participation and hope that you enjoyed the AT Expo! 

  

Enter Email: ________________ 

Are you…* 

Seven Hills Staff Seven Hills Volunteer Family/Friend  

General Public Attendee Other: ______________ 

How did you hear about the Expo? * 

Email Social Media Word of Mouth 

Poster/Flyers Other: ______________ 

What time did you arrive at the Expo? * 

3 PM – 4 PM 4 PM – 5 PM 5 PM – 6 PM 6 PM – 7 PM 

How long did you stay at the Expo? * 

About less than an hour About 1 hour About 2 hours 

About 3 hours About 4 hours 

How much do you agree or disagree with the following questions? * 

I enjoyed the Expo 

Strongly Agree Agree Neutral Disagree Strongly Disagree 

The layout was easy to follow 

Strongly Agree Agree Neutral Disagree Strongly Disagree 
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The Expo was well organized 

Strongly Agree Agree Neutral Disagree Strongly Disagree 

The Expo helped me learn a lot about AT 

Strongly Agree Agree Neutral Disagree Strongly Disagree 

I would go to another Expo by Seven Hills 

Strongly Agree Agree Neutral Disagree Strongly Disagree 

Would you be interested in helping us by answering more questions about the Expo? 

Yes No 

Please provide your name and either phone number or email below. This information is completely 
private. 

__________________________ 
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Morning Exit Survey 

Thank you for attending the AT Expo! As with the other surveys, this survey is completely 

optional and anonymous. We appreciate your participation and hope that you enjoyed 

the AT Expo! 

Enter Email: ________________ 

Are you…* 

Seven Hills Staff Seven Hills Volunteer Family/Friend  

General Public Attendee Other: ______________ 

How did you hear about the Expo? * 

Email Social Media Word of Mouth 

Poster/Flyers Other: ______________ 

What time did you arrive at the Expo? * 

10 AM - 11 AM 11 AM - 12 PM 12 PM - 1 PM 1 PM - 2 PM 

How long did you stay at the Expo? * 

About less than an hour About 1 hour About 2 hours 

About 3 hours About 4 hours 

How much do you agree or disagree with the following questions? * 

I enjoyed the Expo 

Strongly Agree Agree Neutral Disagree Strongly Disagree 
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The layout was easy to follow 

Strongly Agree Agree Neutral Disagree Strongly Disagree 

The Expo was well organized 

Strongly Agree Agree Neutral Disagree Strongly Disagree 

The Expo helped me learn a lot about AT 

Strongly Agree Agree Neutral Disagree Strongly Disagree 

I would go to another Expo by Seven Hills 

Strongly Agree Agree Neutral Disagree Strongly Disagree 

Would you be interested in helping us by answering more questions about the 

Expo? 

Yes No 

Please provide your name and either phone number or email below. This 

information is completely private. 

__________________________  
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E(2): Post-Expo Vendor Survey 

We appreciate you being an exhibitor at the Expo and taking the time to answer the following 

questions so we can gather information for Seven Hills and our project. 

On a scale of 1 to 10, how well do you feel this Expo was executed? 

Poor    1 2 3 4 5 6 7 8 9 10    Excellent 

Do you feel the space was large enough? 

Yes No 

How satisfied were you with your location on the Expo floor? 

Not satisfied 1 2 3 4 5  Very satisfied 

How accurate were your expectations for this event? 

The expo fell below my expectations  

The expo met my expectations 

The expo exceeded my expectations 

Would you come to another Expo hosted by Seven Hills? 

Yes No Maybe 
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Do you have any suggestions or recommendations for future Expos? Was there anything 

you did not like and could be improved upon? 

______________________________________________________________________________

______________________________________________________________________________ 

Was there anything you particularly liked about the Expo and would like to see again? 

______________________________________________________________________________

______________________________________________________________________________ 

Was there any information we could have given you to better prepare you for the Expo? 

______________________________________________________________________________

______________________________________________________________________________ 

 

 

 

 

 

 

E(3): Post-Expo Staff Survey 

 



92 

(Section 1) 

We appreciate you attending the Expo and taking the time to answer the following questions so 

we can gather information for Seven Hills and our project. 

 General Questions 

(Section 2) 

On a scale of 1 to 10, how well do you feel this Expo was executed? 

Poor    1 2 3 4 5 6 7 8 9 10    Excellent 

Do you feel the space was large enough? 

Yes No 

Would you be interested in volunteering for another Expo with the Seven Hills 

Foundation? 

Yes No 

Are you a… 

Seven Hills SuperUser (s3) Seven Hills volunteer (s4) SEAC volunteer (done)  

Satisfaction 

(Section 3) 
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This question is only reference to if you worked station. For example, battery interrupter, 

myGaze, Smart Home, etc. 

How satisfied were you with your location on the Expo floor? 

Not satisfied 1 2 3 4 5  Very satisfied  

Expectations 

(Section 4) 

Did this Expo exceed your expectations? 

Yes No 
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Appendix F: Additional Interviews Conducted 

Mrs. Kinne Interview 

Thank you for taking the time to let me interview you for my school project.  My project is 

helping a foundation that takes care of people with disabilities through the use of Assistive 

Technology such as hearing aids, motorized wheelchairs, book readers, and speech devices. 

 My team and I are trying to put on an AT Expo for the foundation.  At this Expo, there will be 

vendors to help teach the staff and public about how to better use the AT that they deal with.  I 

chose you for the interview as you use AT to help teach your students with disabilities.  Again, 

thank you for this opportunity, and I will start with my first question. 

What types of disabilities did you deal with while teaching? 

Some of the disabilities that I deal with are TBI-traumatic Brain Injury, Down Syndrome, 

ADHD, Multiple Disabilities, and CP-Cerebral Palsy. 

Did any of them require some sort of Assistive Technology(AT) to learn? 

Yes, almost every student I teach has or requires some sort of AT to be able to learn in school. 

If so, what types of AT did you encounter while teaching? 

Some of the AT that I use with the students are iPad’s with apps such as Proloquo-2-GO, LAMP, 

cause and effect apps; sounding boards, Picture Exchange Communication System (PECS), and 

devices that enable students to have a “voice”. 

What some of the benefits were of said AT in the education process? 

Allows students who are non-verbal to communicate with me and other students/teachers to 

enhance their learning experience. 
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What were some of the downfalls to the AT? 

Pre-planning (programming the lesson onto the iPad’s and other devices) and vocabulary is time 

consuming as most students I deal with have physical disabilities and require a speech device. 

How do feel about the amount of funding that people who use assistive technology receive? 

I feel as though there is not enough funding to receive the best quality AT available.  The best 

description is there is enough quantity, but not of good enough quality.  For example, one of my 

previous kindergarten students was applying through the district to receive a specific AT.  They 

are now in 5th grade and have yet to receive the AT.  It just got denied by the district and making 

the family pay for it under some sort of Medicare.  As of now, it is on trial being scrutinized on 

whether or not the district or family should pay for it.  However, the process to get much simpler 

technology such as iPads in which all students can use them. 

How do you feel about the variety of AT available from vendors? 

Again, I feel as though there is a great quantity, but not good quality. 

Do you feel as though AT could be improved to better accommodate certain disabilities? 

Yes, we would love an AT consultant to provide direct services in the classroom, currently we 

have a part-time AT consultant who is not always in the room. 

Were you trained on how to use AT before you started working with it? 

Not in all areas.  We have to take our own time to research.  We have a PT AT person in the 

district.  We need a FT person. 

If so, do you feel as though you were properly trained? 

I feel as though there could definitely be a better and more thorough training process. 

Would you be interested in going to an AT Expo to learn how to better use the AT? 
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Yes, depending on the vendors and what they have to offer.  For me, the target would be speech, 

blind, and deaf devices.  Also, devices for those who are severely physically disabled and have to 

communicate via eye movements. 

Would you think an AT Expo would make the task of educating your students easier? 

It depends on the types of vendors and apps provided. 

Do you feel as though AT is useful in the classroom setting to the children for learning? 

Yes, it helps them tremendously and makes my task of teaching them much easier. 

Did you ever attend an AT Expo? 

No. 

Do you have any family or friends that have a disability and require AT for daily tasks? 

No. 

Do you know of any foundations that currently help people with disabilities through the 

use of AT? 

Jake's Help from Heaven. 

Do you know of any previous AT Expo’s nearby? 

No. 

Would you allow me to quote you on anything you have said in this interview? 

Of course. 

Thank you again for taking this time to answer my questions, it really means a lot to our 

project and will help us further our research.  Thank you and have a Happy Thanksgiving. 

My pleasure, if you have any further questions about my answers or other, email me and I will be 

happy to answer them.  Have a great holiday. 
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Appendix G: Assistive Technology Devices Categories 

Academic and Learning Aids: Electronic and non-electronic aids such as calculators, spell 

checkers, portable word processors, and computer/tablet-based software solutions and apps that 

are used by students who has difficulty achieving in the educational curriculum  

Aids for Daily Living: Self-help aids for use in activities such as eating, bathing, cooking, 

dressing, toileting, and home maintenance  

Assistive Listening Devices and Environmental Aids: Electronic and non-electronic aids such 

as amplification devices, closed captioning systems, and environmental alert systems that assist 

students who are hard of hearing or deaf with accessing information that is typically presented 

through an auditory modality  

Augmentative Communication: Electronic and non-electronic devices and software solutions 

that provide a means for expressive and receptive communication for students with limited 

speech and language  

Computer Access and Instruction: Input and output devices, alternative access aids, modified 

or alternative keyboards, switches, special software, and other devices and apps or software 

solutions and that enable students with disabilities to use the classroom computer/tablet  

Environmental Control: Electronic and non-electronic aids such as switches, environmental 

control units, and adapted appliances that are used by students with physical disabilities to 

increase their independence across all areas of the curriculum  

Mobility Aids: Electronic and non-electronic aids such as wheelchairs (manual and electronic), 

walkers, scooters that are used to increase personal mobility  
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Pre-vocational and Vocational Aids: Electronic and non-electronic aids such as picture-based 

task analysis sheets, adapted knobs, and adapted timers and watches that are used to assist 

students in completing pre-vocational and vocational tasks  

Recreation and Leisure Aids: Electronic and non-electronic aids such as adapted books, switch 

adapted toys, and leisure computer-based software applications that are used by students with 

disabilities to increase participation and independence in recreation and leisure activities  

Seating and Positioning: Adaptive seating systems and positioning devices that provide 

students with optimal positioning to enhance participation and access to the curriculum  

Visual Aids: Electronic and non-electronic aids such as magnifiers, talking calculators, Braille 

writers, adapted tape players, screen reading software applications for the computer, and Braille 

note-taking devices that assist students with visual impairments or blindness in accessing and 

producing information that is typically present in a visual (print) modality. 

 

(Department of Education, 2016; Georgia Project for Assistive Technology, 2004; National 

Association of Special Education Teachers, 2007) 
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Appendix H: Assistive Technology Services Detail 

a. The evaluation of the needs of a child with a disability, including a functional evaluation of the 

child in the child’s customary environment;  

b. Purchasing, leasing, or otherwise providing for the acquisition of assistive technology devices 

by children with disabilities;  

c. Selecting, designing, fitting, customizing, adapting, applying, retaining, repairing, or replacing 

assistive technology devices;  

d. Coordinating and use other therapies, interventions, or services with assistive technology 

devices, such as those associated with existing education and rehabilitation plans and programs;  

e. Training or technical assistance for a child with a disability or, if appropriate, that child’s 

family; and f. Training or technical assistance for professionals (including individuals or 

rehabilitation services), employers, or other individuals who provide services to employ, or are 

otherwise substantially involved in the major life functions of children with disabilities.  

 

(Georgia Project for Assistive Technology, 2004) 
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Appendix I: Funding Assistive Technology  

Finding a way to pay for the assistive technology can be determined after finding the type 

of technology needed. Some AT devices are not expensive, while some may be priced at a 

premium. According to the U.S. Department of Labor’s Office of Disability Employment (2016) 

several local and national sources and programs may help pay for AT. For example, school 

systems, government programs, employer/company programs and health insurance can all pay at 

least a substantial portion of the cost if a doctor has prescribed or recommended the assistive 

technology for a patient. School systems will pay for general education-based AT for all of their 

students. Financial assistance in the workplace is possible, as most employers pay a full or partial 

amount so that the employees can work effectively in the workplace.  

A state resource is the Massachusetts Assistive Technology Loan Program (2016) and 

they are an alternative financing program that is funded primarily by state and federal resources. 

They offer low interest cash loans so that families may purchase the AT devices they need. In 

Some other options are the Assistive Technology Financial Loan Program or Alternative Finance 

Program, and Vocational Rehabilitation Agency, and MassMATCH. MassMATCH, or 

Massachusetts’ Initiative to Maximize Assistive Technology in Consumers’ Hands. This 

organization offers resources to connect families and those with disabilities to the technologies 

they need. They have two Assistive Technology Resource Centers (ATRCs), whose motto is 

“See, Touch, and Try”.   

According to the U.S. Department of Labor’s Office of Disability Employment (2016) 

some local sources of funding include the Independent Living Center, Easter Seals or United 
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Cerebral Palsy, and the reusing and recycling of AT. Another such organization is REquipment 

and they offer free, gently used, and refurbished wheelchairs, shower chairs, scooters, and other 

durable medical equipment (DME) to children, adults, and the elderly in Massachusetts— even 

offering delivery within the greater Boston area. Given that cost is most often an issue for 

individuals with disabilities to receive their AT, often such organizations seek to manipulate the 

cost factor in a way that benefits the consumer.  Another example of such an organization would 

be getATstuff (2016), which is an assistive technology exchange and offers an online hub for 

people to shop for AT or advertise AT that they don’t use anymore.  

These resources could prove invaluable to families and those with loved ones who 

desperately need AT, and resources like these could support Seven Hills’ goal of providing 

resources to increase accessibility to technology that families may not know about. 

Assistive Technology Financial Loan Program or Alternative Finance Program 

The Assistive Technology Financial Loan Program or Alternative Finance Program 

(2016) are programs that help people with disabilities pay for assistive technology through low 

or no interest loans (http://www.easterseals.com/ma/who-we-are/history/). This allows people to 

financially afford an AT device that normally may be out of reach for that particular person. 

If there is a problem with financial assistance for the AT device, the Special Needs 

Alliance (2016) is a nonprofit organization that has mostly Elder Law Attorneys in many areas 

that specialize in disability and public benefits law. Special Needs Alliance will at the very 

minimum provide financial planning for the family, but it also takes cases into court if deemed 

necessary to provide the financial assistance needed. The problem with this option is the small 

number of lawyers invited to join the organization. The lawyers are very experienced, with an 
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average legal experience of 18 years and a majority being certified as an Elder Law Attorney. 

Despite this, there are not many lawyers available to help. 

Vocational Rehabilitation Agency 

The Vocational Rehabilitation Agency (2016) can help pay for AT if it is needed for 

work-related or career training purposes. Vocational rehabilitation agencies assist individuals 

with disabilities to prepare for, obtain, maintain, or regain employment that they would have 

previously lost due to the disability. Massachusetts has a Vocational Rehabilitation program that 

assists individuals with disabilities to obtain and maintain employment.  

Independent Living Centers 

An Independent Living Center (ILC) (2016) may be able to help pay for AT devices or 

equipment, or refer someone to programs that can. An Independent Living Program includes 

community-based, cross-disability, non-profit organizations that are designed and operated by 

people with disabilities. An example of an Independent Living Program is Disabled Peoples’ 

International, which is a network of organizations and assemblies of disabled individuals. It was 

created to promote their human rights through participation and equalization of development. 

These organizations are partially or completely run by disabled individuals. They have 

previously hosted programs, rallies and events where more disabled individuals are able to learn 

and demonstrate their abilities for the public to witness. The funding for independent living 

comes from various donations and government funding from grants and project proposals.  
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Appendix J: Advertisement 

For the promotion process of the Expo. Our first step to developing the Expo event was to                 

make our event known. So, we developed an attractive name for the Expo, calling it the AT                 

Expo. After that, we developed the poster/flyer that is shown in the figure below which was                

sent out to the staff at Seven Hills Foundation to provide them with an invitation to the event                  

that has visual aspects and attractions that attract the personnel receiving the email. 
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Appendix K: Expo Layout 
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Appendix L: Expo Pamphlet 

Below is the Expo pamphlet that we had created and was finalized by Seven Hills 

Development to hand out to attendees at the Expo. This pamphlet contains the flyer, Expo layout, 

and a little information regarding each Expo vendor and their station. 
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Appendix M: Superuser Volunteer Sign-Up Sheet  

Below is the SHF volunteer sign-up sheet that they used to volunteer for the Superuser 

stations at the Expo. As there were shifts in the afternoon that were not filled, many of the 

morning session volunteers stayed into the afternoon. 
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Appendix N: Expo Cost Breakdown 

Below are all of the Expo costs broken down by section so Seven Hills can reference                

these costs at any time in the future. However, we could not account for power usage and staff                  

coverage. Staff coverage entailed allowing Superusers to come demonstrate devices at the Expo             

and getting coverage for their typical day time obligations. 

 

  

 



110 

Appendix O: Database Manual 
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Introduction 

The purpose of the database is to house all information regarding every aspect of the Expo so 

that Seven Hills can later reference this for future events and Expos. The database includes 

important aspects that can be used and referenced by Seven Hills Foundation to help develop a 

future Expo. The database was developed on Google sites so that every time they want to create 

something new for the database, it is created through Google Drive. Additionally, a 

well-organized folder consisting of all the files in the database. The information in this database 

is extremely precise with all information it contains, as they are all the exact documents and 

information we use to help create the Expo.  
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Homepage 

The Home page of the site is an introduction to the site.
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2017 EXPO IQP  

 

Expo Images 

In this page, there is a slideshow of pictures that were taken from the 02/22/2017 Expo. 

Expo Videos 

In this page, there is a clip of the Expo during the morning session during the 02/22/2017 Expo. 

Also in this page is a video of the workshop from the 02/22/2017 Expo.  

Final IQP Report 

In this page, the IQP report submitted on 3/3/2017 is provided.  
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Database 

The database page is the location of Surveys, Contacts, Calendar, Thought Box, Staff Discussion 
Board, & Event Coordination.  
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Surveys 

The Survey page provides each survey that we have developed throughout the Expo 

development stage. The organization of this page is as follows: 

➢ Survey Name (Including link to each survey) 

➢ Expo Stage 

➢ Survey Target: This section will be helpful when determining which type of personnel 

the survey has been used for. 

➢ Survey Description: This section describes what the purpose of each survey is. 

➢ Expo Date: The purpose of this section is to help the user determine which Expo the 

survey was created for. 

➢ Results: This selection holds a link that when clicked will redirect the user to the results 

of each survey. If the Results section is labled “N/A”, then it means that the survey was 

created but never actually implemented.  
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Contacts 

The Contacts Page stores contact information of important Expo development resources. 

The resources are divided into four categories to  provide easy access to the needed category. 

These four categories include: Speaker Contact Information, Vendor Contact Information, Seven 

Hills Staff Contact Information, and WPI IQP Student Information. The user is also given the 

option to add a contact. 

 

 

Add Contact 

In the Add Contact Page, the user given the option to add a contact into three different 

categories, which are Staff Contact Information, Vendor Contact Information, & Speaker 

Contact Information.  
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Staff Contact Information 

The staff contact information page is the part of the database that holds the Seven Hills 

Staff that we have reached out to and are working with throughout the project. The list is 

organized by (from left to right) Name, Job Title, Office Location, Email, and Phone. 

The reason that this page is important is because it should help any future IQP or Seven 

Hills Staff member that would like to contact any of which person is on 

 

Vendor Contact Information 

The Vendor Contact page holds the contact information regarding all the contacts of all 

the vendors that we have researched and reached out to. The page is organized (left to right) 

Company Name, Name, Address, Primary Email, Secondary Email, Primary Phone, Secondary 

Phone, Information, and how we could use them. 

The reason that this page is important is because it should help any future IQP or Seven 

Hills Staff member that would like to contact any of which person is on there. It will be used as a 

reference for any questions when developing an expo in the future. 

 

Speaker Contact Information  

The Speaker Contact page holds the contact information regarding all the contacts of all 

the speakers that we have researched and reached out to. The page is organized (left to right) 

Company Name, Name, Address, Primary Email, Secondary Email, Primary Phone, Secondary 

Phone, Information, and How can we use them. 
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The reason that this page is important is because it should help any future IQP or Seven 

Hills Staff member that would like to contact any of which person is on there. It will be used as a 

reference for any questions when developing an expo in the future. 

 

WPI IQP Contact Information 

On this page, there is a list of all of the WPI students and professors who took part in 

setting up the Expo.  It also has the email aliases that we used to get into contact with each other 

and the vendors for the Expo.  This provides all the information regarding the students and 

professors and how to get into contact with them.  Seven Hills can use this spreadsheet later on if 

they ever have a question regarding the Expo project or the database.  This ensures that Seven 

Hills will be able to use everything in the future. 

The reason that this page is important is because it should help any future IQP or Seven 

Hills Staff member that would like to contact any of which person is on there. It will be used as a 

reference for any questions when developing an expo in the future. 

 

Calendar 

The purpose of this page is to assist Seven Hills and WPI staff can set meeting dates, 

reminders and anything else related to the expo on a calendar that everyone can easily access.  

To use this page in the future, a calendar must be added to the page.  

 



122 

Thought Box  

 

The Thought Box is a feature added to the page to allow the staff or students to add their 

thoughts on any topic. Different from the staff discussion board, this page allows a suggestion 

that isn’t based off a subject. There are two parts to this page. 

 

Staff Discussion Board 

The Staff Discussion Board is a feature that allows people to comment on a topic that is 

posted. This is an important feature that will store any question or response so that it can be 

referenced when facing another problem in the future.  
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Event Coordination 

These pages will allow Seven Hills to coordinate this Expo and any events in the future easily 

and in an organized fashion. 

 

Registered Expo Attendees 

This page holds lists of the attendees that have attended the Expo. The user is able to look 

back at previous Expo’s held by Seven Hills. The purpose of including this is to allow the user to 

gather who attended the Expo so that in the future each attendee that was registered can be 

contacted. This page is important because it can be used to promote a future Expo to the 

individuals who attended before. The page content is formatted by first and last name, email 

address, number  of other guests, session attendee, and how they registered.  
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SuperUser Volunteer Sign-up Sheet 

This page is where the user can access the form where the superusers sign up for the Expo. Also 

the Results of the responses are located on this page.  

 

Floor Plan of Bingo Hall for Expo 

This page holds a blueprint of the bingo hall as well as floor plans for the bingo hall. 

Also in this provided is the layout for the Expo from our first draft to our final draft. 
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Part II: Instructions for Altering Database  

 

Edit page (e) 15 

Insert 15 

Insert Uploaded Image 15 

Insert Link 16 

Input Survey 16 

Input Spreadsheet 16 

Input Calendar 16 

Create page (c) 16 

More actions (m) 17 

Edit Site Layout 17 

Additional Instructions 17 

Re-Using Survey 17 
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Edit page (e)  

Insert 

In the Insert tab there are three categories: Common, Gadgets, and Google. 

In the Common Section: upload an image, create a link, make a table of contents, create 

a subpage listing, and add a horizontal line. 

In the Gadgets Section: recent posts, recently uploaded files, recent list items, create a 

textbox, create an html textbox, and add more gadgets. 

In the Google Section: Apps script, add a calendar, add a chart, insert from google drive, 

add photos & post from Google+ account, create a group, create a google hangout, insert 

map, and insert YouTube video. 

Google Drive: Documents, Drawings, Folder, Form, Image, Presentation, Spreadsheet, 

and Video 

After editing the page remember to click “Save” located in the top right corner of the webpage. 

If you would not like to save your changes click “Cancel” located in the top right corner of your 

webpage. 

 

Insert Uploaded Image 

Select Edit page tab → Insert → Image → Upload Images → Select the Image that you wish 

to input → Click Open→ Then Select OK → Select Save  
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Insert Link 

Select Edit page tab → Insert → Link →  Select the Link Location that you wish to input → 

Then Select OK → Select Save  

 

Input Survey 

Select Edit page tab → Insert → Move the cursor over Drive → Select Form → Select the 

Form that you wish to input → Click Select→ Change the Display Options → Select Save  

 

Input Spreadsheet 

Select Edit page tab → Insert → Move the cursor over Drive → Select Spreadsheet → Select 

the spreadsheet that you wish to input → Change the Display Options →Select Save  

 

Input Calendar 

Go to the Calendar page → Click on Edit page → Insert → Select Calendar → Select the 

calendar that you will insert into the page → Save the page once the calendar is place into the 

page. 

Create page (c)  

When creating a page in google sites, you must provide the following: 

Name your page → Select template to use (In the case of this database, you will most likely use 

the “Web Page” option) → Select Location → Select Create located at the top of the page.  

If you would not like to create this page select  Cancel  also located at the top of the page. 

 



128 

 

More actions (m)  

Edit Site Layout 

Go to the More Items button → select Edit Site Layout 

 

 

Additional Instructions 

Re-Using Survey 

When re-using a survey it is important to make a copy of the survey so that the results are not 

altered.  

Open the survey that you would like to re-use → In the top right corner other survey, click the 

Edit this form tab → Select the More tab in the top right corner of the Survey →Select Make a 

copy→ Rename the Survey→ Save 

 

 


